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KATA PENGANTAR

Begitu pentingnya permasalahan pangan mendorong setiap negara untuk
berusaha mewujudkan ketahanan pangan nasional yang berkelanjutan,
sehingga mampu dan dapat menjamin terpenuhinya kebutuhan pangan
sampai dengan tingkat perseorangan. Dalam rangka mewujudkan
ketahanan pangan nasional yang kuat, tentu diperlukan informasi
ketahanan pangan yang akurat dan tertata dengan baik. Hal ini
diamanatkan oleh Undang-undang No. 18 Tahun 2012 tentang Pangan
dan Peraturan Pemerintah No. 17 tahun 2015 tentang Ketahanan Pangan
dan Gizi. Berkaitan dengan hal tersebut, sejak tahun 2005, Badan
Ketahanan Pangan dan World Food Programme (WFP) mengembangkan
Peta Ketahanan dan Kerentanan Pangan/food Security and Vulnerability
Atlas (FSVA). FSVA menyediakan analisis yang dapat dijadikan acuan bagi
pengambil keputusan dalam perencanaan program dan kebijakan
ketahanan pangan dan gizi.

Penyusunan FSVA Kabupaten merupakan upaya untuk mempertajam
analisis FSVA Nasional dan Provinsi yang telah disusun sebelumnya. Guna
mendukung terwujudnya FSVA Kabupaten tersebut, maka disusun
panduan untuk mempermudah para petugas di daerah dalam memahami
dan mengimplementasikan konsep dan aplikasi penyusunan FSVA.
Panduan ini dilengkapi dengan tiga modul, Modul I berisi tentang
Penjelasan Indikator FSVA Kabupaten, Modul II berisi tentang Analisis
FSVA Kabupaten, dan Modul III berisi tentang Pemetaan dengan
Menggunakan Software Quantum-GIS.

Dengan panduan ini, kami berharap Aparat Daerah dapat memahami dan
mengimplementasikan konsep dan aplikasi penyusunan FSVA sehingga
FSVA di masing-masing wilayah dapat disusun. Berbagai penyesuaian
dapat dilakukan, agar FSVA yang dihasilkan lebih mencerminkan kondisi
aktual di masing-masing wilayah.

Kepala Badan Ketahanan Pangan

g Hendriadi, M.Eng.
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I. PENDAHULUAN

1.1. LATARBELAKANG

Undang-undang No. 18 Tahun 2012 tentang Pangan Pasal 114 dan Peraturan
Pemerintah No. 17 tahun 2015 tentang Ketahanan Pangan dan Gizi Pasal 75
mengamanatkan Pemerintah dan Pemerintah Daerah sesuai dengan
kewenangannya berkewajiban membangun, menyusun, dan mengembangkan
Sistem Informasi Pangan dan Gizi yang terintegrasi, yang dapat digunakan
untuk perencanaan, pemantauan dan evaluasi, stabilisasi pasokan dan harga
pangan serta sebagai sistem peringatan dini terhadap masalah pangan dan
kerawanan pangan dan gizi.

Informasi tentang ketahanan dan kerentanan pangan penting untuk
memberikan informasi kepada para pengambil keputusan dalam pembuatan
program dan kebijakan, baik di tingkat pusat maupun tingkat lokal, untuk lebih
memprioritaskan intervensi dan program berdasarkan kebutuhan dan potensi
dampak kerawanan pangan yang tinggi. Informasi tersebut dapat dimanfaatkan
sebagai salah satu instrumen untuk mengelola krisis pangan dalam rangka
upaya perlindungan/penghindaran dari krisis pangan dan gizi baik jangka
pendek, menengah maupun panjang.

Dalam rangka menyediakan informasi ketahanan pangan yang yang akurat dan
komprehensif, maka disusunlah Peta Ketahanan dan Kerentanan Pangan/Ffood
Security and Vulnerability Atlas (FSVA) sebagai salah satu instrumen yang dapat
digunakan untuk monitoring ketahanan pangan wilayah. Di tingkat nasional,
FSVA disusun sejak tahun 2002 melalui kerja sama dengan World Food
Programme (WFP). Pada tahun 2005, kerjasama tersebut menghasilkan Peta
Kerawanan Pangan/Food Insecurity Atlas (FIA). Pada tahun 2009, 2015, dan
2018, disusun Peta Ketahanan dan Kerentanan Pangan/Food Security and
Vuinerability Atlas (FSVA).

Sebagai tindak lanjut penyusunan FSVA Nasional, disusun pula FSVA Provinsi
dengan analisis sampai tingkat kecamatan dan FSVA Kabupaten dengan analisis
sampai tingkat desa. Dengan demikian, permasalahan pangan dapat dideteksi
secara cepat berdasarkan cakupan wilayahnya. FSVA kabupaten telah disusun
sejak tahun 2012 dan dimutakhirkan pada tahun 2016. Untuk mengakomodir
perkembangan situasi ketahanan pangan dan pemekaran wilayah desa, maka
dilakukan pemutakhiran FSVA Kabupaten pada tahun 2019.
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Seperti halnya FSVA Nasional dan Provinsi, FSVA Kabupaten juga menyediakan
sarana bagi para pengambil keputusan untuk secara cepat dalam
mengidentifikasi daerah yang lebih rentan, sehingga program dari berbagai
sektor, seperti pelayanan jasa, pembangunan manusia dan infrastruktur yang
berkaitan dengan ketahanan pangan, dapat memberikan dampak yang lebih
baik terhadap penghidupan serta ketahanan pangan dan gizi masyarakat di
tingkat desa.

Untuk memudahkan petugas di daerah dalam pelaksanaan
penyusunan FSVA Kabupaten, maka disusunlah Buku Panduan. Buku
ini selain memberikan arahan teknis juga memberikan latar belakang
pemilihan indikator dan metodologi analisis ketahanan pangan
wilayah dengan memperhatikan ketersediaan data di tingkat desa.

1.2. KERANGKA KONSEP KETAHANAN PANGAN DAN GIZI

Peran pangan bukan hanya penting untuk memenuhi kebutuhan fisik dasar dan
mencegah kelaparan, namun lebih jauh dari itu peran pangan dengan
kandungan gizi di dalamnya penting bagi peningkatan kecerdasan dan kualitas
hidup untuk menghasilkan manusia yang sehat, cerdas, aktif dan produktif
sebagaimana disebutkan dalam definisi ketahanan pangan. Kecukupan
pemenuhan pangan dalam jumlah dan mutunya berkorelasi positif dengan
produktivitas kerja dan pertumbuhan otak serta kecerdasan yang pada akhirnya
berperan dalam peningkatan kesejahteraan masyarakat.

Dalam undang-undang didefinisikan bahwa ketahanan pangan adalah kondisi
terpenuhinya pangan bagi negara sampai dengan perseorangan yang tercermin
dari tersedianya pangan yang cukup, baik jumlah maupun mutunya, aman,
beragam, bergizi, merata, dan terjangkau serta tidak bertentangan dengan
agama, keyakinan, dan budaya masyarakat, untuk dapat hidup sehat, aktif, dan
produktif secara berkelanjutan. Menimbang pentingnya ketahanan pangan
dalam pembangunan nasional, Bab III Undang-undang Pangan Nomor 18
Tahun 2012 mengamanatkan bahwa Pemerintah harus melakukan perencanaan
penyelenggaraan pangan. Pada pasal 6, penyelenggaraan pangan diarahkan
untuk mewujudkan kedaulatan, kemandirian dan ketahanan pangan.

Definisi ketahanan pangan yang dianut oleh Food and Agricultural Organisation
(FAO) dan dirujuk oleh UU Pangan saat ini mengacu pada konsep awal
ketahanan pangan yang dihasilkan oleh World Food Summit tahun 1996.
Merujuk pada konsep tentang pentingnya ketahanan gizi yang diajukan oleh
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Unicef pada awal tahun 1990-an yang menambahkan aspek penyakit infeksi
sebagai penyebab masalah gizi disamping ketahanan pangan rumah tangga,
maka International Food Policy Research Institute (IFPRI) menyebut konsep
ketahanan pangan FAO tersebut sebagai Ketahanan Pangan dan Gizi (Food and
Nutrition Security). Pada tahun 2012, FAO! mengajukan definisi Ketahanan
Pangan (food security) menjadi Ketahanan Pangan dan Gizi (food and nutrition
security) untuk menyempurnakan konsep dan definisi sebelumnya.

Upaya FAO ini sejalan dengan upaya Standing Committee on Nutrition (SCN),
suatu lembaga non struktural yang juga berada di bawah PBB (United Nations)
yang pada tahun 20132 juga merekomendasikan penyempurnaan definisi
Ketahanan Pangan menjadi Ketahanan Pangan dan Gizi. Dalam pemahaman
baru ini, perwujudan ketahanan pangan tidak hanya berorientasi pada upaya
penyediaan pangan dalam jumlah yang cukup bagi setiap individu, namun juga
harus disertai upaya untuk meningkatkan efektivitas pemanfaatan pangan bagi
terciptanya status gizi yang baik bagi setiap individu. Dalam konteks ini,
optimalisasi pemanfaatan pangan tidak cukup hanya dari kualitas pangan yang
dikonsumsi, namun juga harus didukung oleh terhindarnya setiap individu dari
penyakit infeksi yang dapat mengganggu tumbuh kembang dan kesehatan
melalui kecukupan air bersih dan kondisi sanitasi lingkungan yang baik.
Kerangka pikir ketahanan pangan dan gizi ini dituangkan dalam Gambar 1.1.

1 Disampaikan pada Commitee on World Food Security, 36th sessions of 15-22 October 2012, Rome-
Italia

2 Disampaikan pada UNSCN Meeting of the Minds and Nutrition Impact of Food System, 25-28 March di
New York
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Gambar 1.1. Konsep Ketahanan Pangan dan Gizi
(Sumber: FAO dan UNSCN)

Analisis dan pemetaan FSVA dilakukan berdasarkan pada pemahaman
mengenai ketahanan pangan dan gizi seperti yang tercantum dalam Kerangka
Konsep Ketahanan Pangan dan Gizi (Gambar 1.1). Kerangka konseptual
tersebut dibangun berdasarkan tiga pilar ketahanan pangan, vyaitu:
ketersediaan, akses dan pemanfaatan pangan, serta mengintegrasikan gizi dan
kerentanan di dalam keseluruhan pilar tersebut.

Ketersediaan pangan adalah kondisi tersedianya pangan dari hasil produksi
dalam negeri, cadangan pangan, serta pemasukan pangan (termasuk
didalamnya impor dan bantuan pangan) apabila kedua sumber utama tidak
dapat memenuhi kebutuhan. Ketersediaan pangan dapat dihitung pada tingkat
nasional, regional, kecamatan dan tingkat masyarakat.

Akses pangan adalah kemampuan rumah tangga untuk memperoleh cukup
pangan yang bergizi, melalui satu atau kombinasi dari berbagai sumber seperti:
produksi dan persediaan sendiri, pembelian, barter, hadiah, pinjaman dan
bantuan pangan. Pangan mungkin tersedia di suatu daerah tetapi tidak dapat
diakses oleh rumah tangga tertentu jika mereka tidak mampu secara fisik,
ekonomi atau sosial, mengakses jumlah dan keragaman makanan yang cukup.
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Pemanfaatan pangan merujuk pada penggunaan pangan oleh rumah tangga
dan kemampuan individu untuk menyerap dan memetabolisme zat gizi.
Pemanfaatan pangan juga meliputi cara penyimpanan, pengolahan dan
penyiapan makanan, keamanan air untuk minum dan memasak, kondisi
kebersihan, kebiasaan pemberian makan (terutama bagi individu dengan
kebutuhan makanan khusus), distribusi makanan dalam rumah tangga sesuai
dengan kebutuhan individu (pertumbuhan, kehamilan dan menyusui), dan
status kesehatan setiap anggota rumah tangga. Mengingat peran yang besar
dari seorang ibu dalam meningkatkan profil gizi keluarga, terutama untuk bayi
dan anak-anak, pendidikan ibu sering digunakan sebagai salah satu proxy
untuk mengukur pemanfaatan pangan rumah tangga.

Kerentanan dalam peta ini selanjutnya merujuk pada kerentanan terhadap
kerawanan pangan dan gizi. Tingkat kerentanan individu, rumah tangga atau
kelompok masyarakat ditentukan oleh pemahaman terhadap faktor-faktor risiko
dan kemampuan untuk mengatasi situasi tertekan. Kerawanan pangan dapat
menjadi kondisi yang kronis atau transien. Kerawanan pangan kronis adalah
ketidakmampuan jangka panjang untuk memenuhi kebutuhan pangan minimum
dan biasanya berhubungan dengan struktural dan faktor-faktor yang tidak
berubah dengan cepat, seperti iklim setempat, jenis tanah, sistem
pemerintahan daerah, infrastruktur publik, sistim kepemilikan lahan, distribusi
pendapatan dan mata pencaharian, hubungan antar suku, tingkat pendidikan,
sosial budaya/adat istiadat dll.

Kerawanan pangan transien adalah ketidakmampuan sementara yang
bersifat jangka pendek untuk memenuhi kebutuhan pangan minimum yang
sebagian besar berhubungan dengan faktor dinamis yang dapat berubah
dengan cepat/tiba-tiba seperti penyakit menular, bencana alam, pengungsian,
perubahan fungsi pasar, tingkat hutang dan migrasi. Perubahan faktor dinamis
tersebut umumnya menyebabkan kenaikan harga pangan yang lebih
mempengaruhi penduduk miskin dibandingkan penduduk kaya, mengingat
sebagian besar dari pendapatan penduduk miskin digunakan untuk membeli
makanan. Kerawanan pangan transien yang berulang dapat menyebabkan
kerawanan aset rumah tangga, menurunnya ketahanan pangan dan akhirnya
dapat menyebabkan kerawanan pangan kronis.
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1.3. TUJUAN

Panduan FSVA Kabupaten ini disusun dengan tujuan:

1. Memberikan acuan bagi petugas di daerah dalam penyusunan FSVA
Kabupaten; dan

2.  Meningkatkan kemampuan petugas dalam melaksanakan analisis
ketahanan pangan wilayah.
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I1. METODOLOGI FSVA KABUPATEN

2.1. RINGKASAN INDIKATOR

Kerentanan pangan dan gizi adalah masalah multi-dimensional yang
memerlukan analisis dari sejumlah parameter. Kompleksitas masalah ketahanan
pangan dan gizi dapat dikurangi dengan mengelompokkan beberapa indikator
ke dalam tiga kelompok yang berbeda tetapi saling berhubungan, yaitu
ketersediaan pangan, keterjangkauan/akses rumah tangga terhadap pangan
dan pemanfaatan pangan secara individu. Pertimbangan gizi, termasuk
ketersediaan dan keterjangkauan bahan pangan bergizi, tersebar di dalam tiga
kelompok tersebut.

Kerentanan terhadap kerawanan pangan di tingkat nasional, provinsi maupun
kabupaten memiliki karakteristiknya masing-masing sehingga tidak semua
indikator nasional maupun provinsi dapat digunakan untuk memetakan
kerentanan terhadap kerawanan pangan di tingkat kabupaten. Pemilihan
indikator FSVA Kabupaten didasarkan pada: (i) Hasil review terhadap pemetaan
wilayah rentan rawan pangan yang telah dilakukan sebelumnya; (ii) Tingkat
sensitivitas dalam mengukur situasi ketahanan pangan dan gizi; (iii)
Keterwakilan pilar ketahanan pangan dan gizi; dan (iv) Ketersediaan data di
seluruh desa. Dengan pertimbangan tersebut, maka indikator yang digunakan
dalam FSVA Kabupaten sebanyak enam indikator yang mencerminkan tiga
aspek ketahanan pangan (Tabel 2.1.)

Tabel 2.1. Indikator FSVA Kabupaten 2019

Indikator | Definisi | Sumber Data
A. Aspek Ketersediaan Pangan
Rasio luas baku lahan Luas baku lahan sawah e Pusat Data dan
sawah terhadap luas dibandingkan dengan luas Informasi,
wiyah desa wiayah desa Kementan 2018
e Luas wilayah desa,
BPS
Rasio jumlah sarana dan Jumlah sarana dan prasarana | e Potensi Desa 2018,
prasarana penyedia penyedia pangan (pasar, BPS
pangan terhadap jumlah minimarket, toko, warung,  Jumlah Rumah
rumah tangga restoran, dl) dibandingkan Tangga 2018 dari
dengan jumlah rumah tangga Proyeksi Sensus
di desa Penduduk (SP)
2010
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Indikator

Definisi

Sumber Data

B. Aspek Akses terhadap Pangan

Rasio jumlah penduduk
dengan tingkat
kesejahteraan terendah
terhadap jumlah penduduk
desa

Jumlah penduduk dengan
status kesejahteraan terendah
(penduduk dengan tingkat
kesejahteraan pada Desil 1)
dibandingkan dengan jumlah
penduduk desa

e Data Terpadu
Program
Penanganan Fakir
Miskin 2018

e Jumlah Rumah
Tangga 2018 dari
Proyeksi SP 2010

Desa yang tidak memiliki
akses penghubung
memadai melalui darat, air
atau udara

Desa yang tidak memilki akses
penghubung memadaidengan
kriteria: (1) Desa dengan
sarana transportasi darat tidak
dapat dialui sepanjang tahun;
atau (2) Desa dengan sarana
transportasi air atau udara
namun tidak tersedia angkutan
umum

Potensi Desa 2018,
BPS

C. Aspek Pemanfaatan Pangan

Rasio jumlah rumah
tangga tanpa akses air
bersih terhadap jumlah
rumah tangga

Jumlah rumah tangga Desil 1
s/d 4 dengan sumber air bersih
tidak terlindung dibandingkan
dengan jumlah rumah tangga
di desa

e Data Terpadu
Program
Penanganan Fakir
Miskin 2018

¢ Jumlah rumah
tangga 2018 dari
Proyeksi SP 2010

Rasio jumlah penduduk
desa per tenaga kesehatan
terhadap kepadatan
penduduk

Jumlah penduduk desa per
tenaga kesehatan yang terdiri
dari: 1) Dokter
umum/spesialis; 2) Dokter
gigi; 3) Bidan; dan 4) Tenaga
kesehatan lainnya (perawat,
tenaga kesehatan masyarakat,
tenaga gizi, apoteker/asisten
apoteker) dibandingkan
dengan kepadatan penduduk.

e Potensi Desa 2018,
BPS

e Jumlah penduduk
2018 dari Proyeksi
SP 2010

2.2. PENENTUAN RANGE INDIKATOR INDIVIDU

Penentuan range/cut off point indikator individu menggunakan pendekatan
sebaran data empiris pada masing-masing kabupaten. Indikator individu dibagi
menjadi enam prioritas, kecuali indikator desa yang tidak memiliki akses
penghubung yang memadai menggunakan empat prioritas sesuai kategori yang
terdapat pada data Podes.
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2.3. ANALISIS KOMPOSIT

Analisis komposit FSVA Kabupaten dilakukan dengan metode pembobotan
terhadap enam indikator yang digunakan. Penggunaan pembobotan dalam
FSVA didasarkan pada pertimbangan tingkat pengaruh indikator dalam
menentukan status ketahanan pangan suatu wilayah. Penentuan bobot
dilakukan dengan menggunakan pendekatan proporsional, dimana setiap aspek
ketahanan pangan memiliki bobot yang sama, yaitu 1/3.

Penghitungan skor komposit dilakukan dengan rumus:

Yj = a1Xij + a2X2j + ... + aeXej

Keterangan:
Y;j : Skor komposit desa ke-j
a1, @2,,..a : Bobot masing-masing indikator

Xij, X25,.. X6j  : Nilai masing-masing indikator pada desa ke-j

Hasil perhitungan skor komposit selanjutnya diklasifikasikan kedalam enam
prioritas berdasarkan nilai cut off point (ambang batas) komposit. Cut off point
komposit diperoleh dari hasil perhitungan antara bobot dengan cut off point
indikator individu. Prioritas 1 merupakan prioritas utama yang menggambarkan
tingkat kerentanan pangan wilayah yang paling tinggi, sedangkan prioritas 6
menunjukkan wilayah dengan tingkat ketahanan pangan yang paling baik.
Dengan kata lain, wilayah prioritas 1 memiliki tingkat resiko kerawanan pangan
yang lebih besar dibandingkan wilayah lainnya. Meskipun demikian, wilayah
yang berada pada prioritas 1 tidak berarti semua penduduknya berada dalam
kondisi rawan pangan, juga sebaliknya wilayah pada prioritas 6 tidak berarti
semua penduduknya tahan pangan.

2.4. PEMETAAN

Hasil analisis komposit kemudian divisualisasikan ke dalam sebuah bentuk peta.
Selain itu, indikator individu juga akan divisualisasikan ke dalam bentuk peta
berdasarkan range indikatornya, sehingga akan dihasilkan tujuh peta yang
terdiri dari satu peta komposit dan enam peta indikator individu.

Peta-peta yang dihasilkan menggunakan pola warna seragam dalam gradasi
warna merah dan hijau. Gradasi merah menunjukkan variasi tingkat kerentanan
terhadap kerawanan pangan dan gradasi hijau menggambarkan variasi
ketahanan pangan. Warna yang semakin tua menunjukkan status yang lebih
tinggi dari situasi ketahanan atau kerentanan pangan. Pemetaan dilakukan
dengan menggunakan software Quantum-Gis.
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2.5. TAHAPAN PENYUSUNAN FSVA KABUPATEN

Dalam rangka penyusunan FSVA Kabupaten, maka perlu dibentuk Tim
Penyusunan FSVA. Tim ini terdiri dari Tim Pengarah dan Tim Pelaksana yang
berasal dari lintas sektor. Tim Pengarah dan Tim Pelaksana di tingkat
kabupaten terdiri dari lintas sektor, antara lain: BAPPEDA, Dinas Ketahanan
Pangan, Dinas Pertanian, Badan Pusat Statistik, Dinas Kesehatan, Dinas Sosial,
dan instansi terkait lainnya.

Tugas Tim Pengarah sebagai berikut:

Memberikan arahan kepada Tim Pelaksana dalam pelaksanaan penyusunan
FSVA agar dapat menyelesaikan laporan FSVA sesuai waktu yang telah
ditetapkan dan mereview hasil FSVA sebelum dilaporkan kepada pimpinan
daerah, serta bertanggung jawab atas pekerjaan penyusunan FSVA.

Tugas Tim Pelaksana sebagai berikut:

1. Melakukan pertemuan koordinasi untuk validasi data dengan dinas teknis
terkait;

2. Melakukan konsolidasi dan kompilasi data pendukung penyusunan FSVA;

3. Mengolah dan menganalisis data sebagai bahan penyusunan laporan FSVA;

4. Menyusun laporan FSVA.

Penyusunan FSVA dilaksanakan dengan tahapan-tahapan:

1. Pembentukan Tim Penyusunan FSVA Kabupaten;

2. Pertemuan teknis untuk validasi data;

3. Peningkatan kapasitas petugas dalam penyusunan FSVA (metodologi,
pengumpulan data dan analisis data);

4. Pengumpulan data tingkat kecamatan dan desa sebagai tambahan informasi

untuk penyusunan laporan FSVA;

Analisis data dan pembuatan peta;

Pertemuan untuk mereview hasil analisis dan peta FSVA;

Finalisasi FSVA dan penyusunan laporan FSVA;

Pencetakan laporan FSVA; dan

Sosialisasi hasil FSVA.
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MODUL I
PENJELASAN INDIKATOR

FSVA KABUPATEN




I. ASPEKKETERSEDIAANPANGAN

Berdasarkan Undang-Undang No. 18 Tahun 2012 tentang Pangan dijelaskan
bahwa yang dimaksud dengan ketersediaan pangan adalah kondisi tersedianya
pangan hasil produksi dalam negeri dan cadangan pangan nasional serta impor
apabila kedua sumber utama tidak dapat memenuhi kebutuhan. Ketersediaan
pangan ditentukan oleh produksi pangan di wilayah tersebut, perdagangan
pangan melalui mekanisme pasar di wilayah tersebut, stok yang dimiliki oleh
pedagang dan cadangan pemerintah, dan bantuan pangan dari pemerintah
atau organisasi lainnya.

Mayoritas bahan pangan yang diproduksi maupun didatangkan dari luar wilayah
harus masuk terlebih dahulu ke pasar sebelum sampai ke rumah tangga. Oleh
karena itu, selain kapasitas produksi pangan, keberadaan sarana dan prasarana
penyedia pangan seperti pasar akan terkait erat dengan ketersediaan pangan di
suatu wilayah. Untuk menggambarkan situasi ketersediaan pangan dalam
penyusunan FSVA Kabupaten, maka indikator yang digunakan adalah: (1) Rasio
luas baku lahan sawah terhadap luas wilayah desa; dan (2) Rasio jumlah
sarana dan prasarana penyedia pangan terhadap jumlah rumah tangga.

1.1. RASIO LUAS BAKU LAHAN SAWAH TERHADAP LUAS WILAYAH DESA

Rasio luas baku lahan sawah terhadap luas wilayah kabupaten adalah
perbandingan antara luas baku lahan sawah dengan luas wilayah desa. Lahan
sawah merupakan lahan pertanian yang berpetak-petak dan dibatasi oleh
pematang (galengan), saluran untuk menahan/menyalurkan air, yang biasanya
ditanami padi sawah tanpa memandang dari mana diperolehnya atau status
lahan tersebut!l. Lahan sawah mencakup sawah pengairan, tadah hujan, sawah
pasang surut, rembesan, lebak dan lain sebagainya.

Lahan pertanian diantaranya lahan sawah memiliki nilai manfaat penggunaan
(use value) yang didapat dari hasil kegiatan usaha tani yang dilakukan pada
lahan tersebut?. Diantara manfaat adanya lahan sawah di suatu wilayah adalah
tersedianya produksi pangan, khususnya padi sebagai sumber karbohidrat
utama masyarakat Indonesia. Sekitar separuh dari kebutuhan energi per orang

1 BPS (2019). (Online) dapat diakses di:
https://www.bps.go.id/subject/53/tanaman-pangan.html

2 Sumaryo & Tahlim (2005) Pemahaman Dampak Negatif Konversi Lahan Sawah
Sebagai Landasan Perumusan Strategi Pengendaliannya. Prosiding Seminar
Penanganan Konversi Lahan dan Pencapaian Pertanian Abadi. LPPM IPB. Bogor.
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per hari berasal dari sumber pangan karbohidrat yang sebagian besar dipenuhi
dari komoditas padi.

Rasio lahan sawah terhadap luas wilayah desa digunakan sebagai salah satu
indikator dalam aspek ketersediaan pangan karena lahan sawah memiliki
korelasi yang positif terhadap tingkat ketersediaan pangan dengan
mempengaruhi kapasitas produksi pangan3. Oleh sebab itu, semakin tinggi rasio
luas lahan sawah terhadap luas wilayah desa maka diasumsikan ketersediaan
pangan juga akan semakin baik, begitu pula sebaliknya.

Sumber data:
e Pusat Data dan Informasi, Kementan 2018
e Luas wilayah desa, BPS

1.2. RASIO JUMLAH SARANA DAN PRASARANA PENYEDIA PANGAN
TERHADAP JUMLAH RUMAH TANGGA

Rasio jumlah sarana dan prasarana penyedia pangan terhadap jumlah rumah
tangga adalah perbandingan antara jumlah sarana dan prasarana penyedia
pangan (pasar, minimarket, toko, warung, restoran, dll) dengan jumlah rumah
tangga di desa. Sarana dan prasarana penyedia pangan terdiri dari: (1) Pasar
dengan bangunan permanen (memiliki atap, lantai, dan dinding); (2) Pasar
dengan bangunan semi permanen (memiliki atap dan lantai, tanpa dinding); (3)
Pasar tanpa bangunan (misalnya: pasar subuh, pasar terapung, dll.); (4)
Jumlah minimarket/swalayan (tempat usaha di bangunan tetap untuk menjual
berbagai jenis barang secara eceran dengan label harga, sistem pelayanan
mandiri, luas lantai < 400 m2); (5) Toko/warung kelontong (tempat usaha di
bangunan tetap untuk menjual berbagai jenis barang keperluan sehari—hari
secara eceran, tanpa ada sistem pelayanan mandiri); (6) Toko/warung
kelontong yang menjual bahan pangan (sembako); (7) Warung/kedai makanan
minuman (usaha pangan siap saji di bangunan tetap, pembeli biasanya tidak
dikenai pajak); (8) Restoran/rumah makan (usaha pangan siap saji di bangunan
tetap, pembeli biasanya dikenai pajak); (9) Kelompok pertokoan (minimal 10
toko dan mengelompok dalam satu lokasi); (10) Hotel (menyediakan jasa
akomodasi dan ada restoran, penginapan dengan izin usaha sebagai hotel); dan
(11) Penginapan: hostel/motel/losmen/wisma (menyediakan akomodasi,
penginapan dengan izin usaha bukan sebagai hotel).

3 Yudhistira (2013) Analisis Dampak Alih Fungsi Lahan Pertanian Terhadap
Ketahanan Pangan di Kabupaten Bekasi Jawa Barat. Fakultas Ekonomi dan
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Sarana dan prasarana penyedia pangan diasumsikan sebagai tempat
penyimpan pangan (stok pangan) yang diperoleh dari petani sebagai produsen
pangan maupun dari luar wilayah, yang selanjutnya disediakan bagi masyarakat
untuk konsumsi. Oleh karena itu, semakin tinggi rasio sarana dan prasarana
penyedia pangan terhadap jumlah rumah tangga di desa maka diasumsikan
semakin baik tingkat ketersediaan pangan di desa tersebut. Indikator ini
digunakan sebagai indikator pelengkap indikator sebelumnya karena bisa jadi
suatu wilayah desa tidak memiliki potensi untuk memproduksi pangan sendiri,
namun desa tersebut memiliki sarana dan prasarana penyedia pangan sehingga
ketersediaan pangan di desa tersebut masih dapat mencukupi kebutuhan
konsumsi masyarakat.

Sumber data:
e Potensi Desa 2018, BPS
e Jumlah Rumah Tangga 2018 dari Proyeksi Sensus Penduduk (SP) 2010
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II. ASPEKKETERJANGKAUAN PANGAN

Keterjangkauan pangan atau akses terhadap pangan adalah kemampuan
rumah tangga untuk memperoleh cukup pangan, baik yang berasal dari
produksi sendiri, stok, pembelian, barter, hadiah, pinjaman dan bantuan
pangan. Pangan mungkin tersedia di suatu wilayah tetapi tidak dapat diakses
oleh rumah tangga tertentu karena terbatasnya: (1) Akses ekonomi:
kemampuan keuangan untuk membeli pangan yang cukup dan bergizi; (2)
Akses fisik: keberadaan infrastruktur untuk mencapai sumber pangan;
dan/atau (3) Akses sosial: modal sosial yang dapat digunakan untuk
mendapatkan dukungan informal dalam mengakses pangan, seperti barter,
pinjaman atau program jaring pengaman sosial. Dalam penyusunan FSVA
Kabupaten, indikator yang digunakan dalam aspek keterjangkauan pangan
hanya mewakili akses ekonomi dan fisik saja, yaitu: (1) Rasio jumlah penduduk
dengan tingkat kesejahteraan terendah terhadap jumlah penduduk desa; dan
(2) Desa yang tidak memiliki akses penghubung memadai melalui darat, air
atau udara.

2.1. RASIO JUMLAHPENDUDUKDENGAN TINGKAT KESEJAHTERAAN
TERENDAH TERHADAP JUMLAH PENDUDUK DESA

Rasio jumlah penduduk dengan tingkat kesejahteraan terendah terhadap
jumlah penduduk desa adalah perbandingan antara jumlah penduduk dengan
status kesejahteraan terendah (penduduk dengan tingkat kesejahteraan pada
Desil 1) dengan jumlah penduduk desa. Penduduk dengan tingkat
kesejahteraan pada Desil 1 merupakan penduduk yang masuk dalam 10 persen
penduduk dengan status kesejahteraan terendah di Indonesia berdasarkan
Data Terpadu Program Penanganan Fakir Miskin tahun 2018.

Penduduk dengan tingkat kesejahteraan terendah diasumsikan tidak memiliki
daya beli yang memadai untuk mengakses pangan yang cukup dalam rangka
memenuhi kebutuhan dasar hidupnya sehingga akan mempengaruhi status
kerawanan pangan.

Sumber data:
e Data Terpadu Program Penanganan Fakir Miskin 2018
e Jumlah Rumah Tangga 2018 dari Proyeksi SP 2010

4FAO (2015) The causes of food insecurity in rural areas. (Online) Dapat diakses di:
http://www.fao.org/docrep/003/x8406e/ X8406e02.htm.
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2.2. DESA YANG TIDAK MEMILIKI AKSES PENGHUBUNG MEMADAI
MELALUI DARAT, AIR ATAU UDARA

Desa yang tidak memiliki akses penghubung memadai melalui darat, air atau

udara merupakan desa yang tidak memiliki akses penghubung memadai

dengan kriteria: (1) Desa dengan sarana transportasi darat tidak dapat dilalui

sepanjang tahun; atau (2) Desa dengan sarana transportasi air atau udara

namun tidak tersedia angkutan umum.

Masyarakat yang tinggal di wilayah terisolir atau terpencil tanpa sarana
penghubung yang memadai dapat menimbulkan “kemiskinan lokal” karena
mereka kurang memiliki akses ke pelayanan jasa secara maksimal, termasuk
dalam memperoleh pangan.

Sumber data :
e Potensi Desa (PODES) 2018, BPS
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III. ASPEKPEMANFAATAN PANGAN

Aspek ketiga dari konsep ketahanan pangan adalah pemanfaatan pangan.
Pemanfaatan pangan meliputi: (1) Pemanfaatan pangan yang bisa di akses oleh
rumah tangga; dan (2) Kemampuan individu untuk menyerap zat gizi secara
efisien oleh tubuh. Pemanfaatan pangan juga meliputi cara penyimpanan,
pengolahan, dan penyajian makanan termasuk penggunaan air selama proses
pengolahannya serta kondisi budaya atau kebiasaan dalam pemberian makanan
terutama kepada individu yang memerlukan jenis pangan khusus sesuai dengan
kebutuhan masing-masing individu (saat masa pertumbuhan, kehamilan,
menyusui, dll) atau status kesehatan masing-masing individu. Dalam
penyusunan FSVA Kabupaten, aspek pemanfaatan pangan meliputi indikator
sebagai berikut: (1) Rasio jumlah rumah tangga tanpa akses air bersih terhadap
jumlah rumah tangga; dan (2) Rasio jumlah penduduk desa per tenaga
kesehatan terhadap kepadatan penduduk.

3.1. RASIO JUMLAHRUMAH TANGGA TANPA AKSES AIR BERSIH
TERHADAP JUMLAH RUMAH TANGGA

Rasio jumlah rumah tangga tanpa akses air bersih terhadap jumlah rumah
tangga merupakan perbandingan antara jumlah rumah tangga Desil 1-4 dengan
sumber air bersih tidak terlindung dengan jumlah rumah tangga di desa. Air
bersih adalah air yang digunakan untuk keperluan sehari-hari yang kualitasnya
memenuhi syarat kesehatan dan dapat diminum apabila telah dimasak>.
Sumber air bersih yang tidak terlindungi berpotensi meningkatkan angka
kesakitan serta menurunkan kemampuan dalam menyerap makanan yang pada
akhirnya akan mempengaruhi status gizi individu.

Sumber data:
e Data Terpadu Program Penanganan Fakir Miskin 2018
e Jumlah rumah tangga 2018 dari Proyeksi SP 2010

3.2. RASIO JUMLAHPENDUDUKDESA PER TENAGA KESEHATAN TERHADAP
KEPADATAN PENDUDUK

Rasio jumlah penduduk desa per tenaga kesehatan terhadap kepadatan

penduduk adalah jumlah penduduk desa per tenaga kesehatan yang terdiri

dari: (1) Dokter umum/spesialis; (2) Dokter gigi; (3) Bidan; dan (4) Tenaga

kesehatan lainnya (perawat, tenaga kesehatan masyarakat, tenaga gizi,

5Permenkes 416 Tahun 1990
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apoteker/asisten apoteker) dibandingkan dengan kepadatan penduduk. Tenaga
kesehatan berperan penting dalam menurunkan angka kesakitan penduduk
(morbiditas) dan meningkatkan pengetahuan masyarakat akan pentingnya
makanan yang beragam bergizi seimbang dan aman.

Rasio jumlah penduduk desa per tenaga kesehatan terhadap kepadatan
penduduk menunjukkan kemampuan jumlah tenaga kesehatan yang ada di
wilayah desa untuk melayani masyarakat. Jumlah tenaga kesehatan yang
memadai akan meningkatkan status pemanfaatan pangan masyarakat.

Sumber data:
e Potensi Desa 2018, BPS
e Jumlah penduduk 2018 dari Proyeksi SP 2010
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MODUL 11
ANALISIS FSVA KABUPATEN




I. UMUM

Penyusunan Peta Ketahanan dan Kerantanan Pangan (FSVA) dibangun
dari beberapa indikator yang terdiri dari tiga aspek ketahanan pangan,
yaitu ketersediaan pangan, akses pangan, dan pemanfatan pangan.
Data indikator FSVA Kabupaten dengan level desa berasal dari lintas
sektor. Metode indeks gabungan (komposit) digunakan untuk
merangkum data dari 6 indikator kerentanan pangan kronis sehingga
menjadi kesimpulan umum vyang berguna dalam pengambilan
kebijakan.

Indeks komposit lebih mudah menggambarkan kondisi kerentanan
dan ketahanan pangan suatu wilayah secara umum. Desa-desa pada
kelompok prioritas yang sama akan memiliki karakteristik yang relatif
sama. Analisis komposit FSVA dilakukan dengan metode pembobotan,
dimana masing-masing prioritas komposit akan memiliki cut-off
(ambang batas) berdasarkan pembobotan pada masing-masing
indikator. Dengan adanya cut-off point komposit ini, selain dapat
menggambarkan kondisi ketahanan pangan dan gizi, Analisis
Komposit FSVA juga akan dapat memberikan kemudahan dalam
melihat trend/kecenderungan perubahan yang terjadi antar periode
analisis.

Cut-off point Indeks Komposit tersebut diperoleh berdasarkan hasil
pengkalian antara bobot indikatorindividu FSVA dengan Cut-off point
indikator individu yang bersangkutan, kemudian hasil pengkalian
antara bobot dengan cut-off point dari masing-masing indikator
individu tersebut dijumlahkan.

Penghitungan Indeks Komposit masing-masing wilayah (desa)
dilakukan dengan rumus:

Y; = ai1Xij + a2X2j + ... + asXsj + aeXsj
Keterangan:
Y; : Indeks komposit desa ke-j
as : Bobot masing-masing indikator

.....

X1j, X2j,.. Xej : Nilai masing-masing indikator pada kecamatan ke-j yang
sudah dilakukan standarisasi dua tahap (Z-Score dan
Scale)
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II. LANGKAH-LANGKAH ANALISIS

2.1 Pengenalan Form Analisis FSVA Kabupaten 2019

Form analisis FSVA ini dibuat dalam bentuk aplikasi excel sederhana
yang terdiri dari tiga file terintegrasi yaitu: 0.Form Validasi Data &
Hitung Indikator Ver.Hsl1; 1.Form Penentuan Cut off Point
Individu Ver.Hs1; dan 2.Form Analisis FSVA Kab 2019 Ver.Hs1.

0.Form Validasi Data & Hitung Indikator Ver.Hsl digunakan
untuk menginput data mentah Indikator dan data pendukung
sekaligus untuk mevalidasi data. Dengan form ini diharapkan jika ada
sumber data pembanding yang lain bisa dimasukkan kedalam form ini.
Sehingga record data bisa tersimpan dengan baik sebagai database.

Form ini juga berfungsi untuk menghitung otomatis data indikator
FSVA yang akan digunakan dalam tahapan selanjutnya. Tampilan form
tersebut bisa dilihat pada gambar dibawah ini:

0. Form Validasi Data & Hitung Indikator Ver.Hsl.xdsx - Excel

Review  View  Help ' Tell me what you want to do
=
"D’X‘ Calibri u - K x| === ¥- [&WapTe General - ['.'-'Igl i:57] = E‘I' EX E] - QY p
=R v o~
Paste Bl U-|[il- D-A-| =SB = E= | EMergesiCenter - | -9 5 |58 8§ | Conditional Formatas Cel Insert Delete Format _ Sort& Find&
- Formatting = Table~ Styl Filter = Select =
Clipboard 1= Font 5 Alignment 5 Number 5 Styles Cell Editing -
AB < £ || No v
A 8 < D E £ G H 1 J K L [ N S
1 |VALIDASI DATA INDIKATOR KETERSEDIAAN Kabupaten/ Kota :
2 | Food Security and Vulnerability Atias (FSVA-Desa) 2019
3
Pusdatin- . .
Sumber BPS Dinas validasi KESEPAKATAN Podes 2018 BPS g
) Kementan
3 Tahun 2018 2018 2018 2018 2018 1
o, Nom Kecamatan Koe kee Kote Desa/ Mama Desa/ 1.luaslahan 1l luaslahan  L.luaslahan  1.Luaslahan D;Dk::am':;“ Keterangan Luas 2';";::::’“ 2'“';';:?::'“&2'“';:
. | Kelurahan Kelurahan Sawah Sawah Sawah Sawah T Lahan Sawah P e R s
o
8
)
10
1
12
13
14
15
16
17
18
13
20
1
2
23
2
= -
1. Indikator Ketersediaan _ 3. Indikator Pemanfaatan _ (O] 4 >
i3] m - 1 + 80%
- - % } - () D

21/04/2019

-~ wwl)

Pada form ini terdapat lima sheet bagian vyaitu: 1.Indikator
Ketersediaan; 2.Indikator Akses Pangan; 3.Indikator
Pemanfaatan; 4.Data Pendukung; dan 5.Hitung Indikator.
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1.Form Penentuan Cut off Point Individu Ver.Hsl digunakan
untuk menghitung titik-titik potong pada sebaran data pada masing-
masing indikator individu yang dibagi menjadi enam kelas. Titik
potong tersebut berada pada posisi titik 15%, 30%, 50%, 70%, dan
85%.

Titik potong (cut off point) tersebut akan dijadikan dasar dalam
menentukan batas-batas pengelompokan pada masing-masing
indikator individu. Selain itu cut off point indikator individu yang
dihasilkan akan digunakan pada tahapan analisis berikutnya. Gambar
form bisa dilihat sebagai berikut:

Bagian Data Indikator

1. Form Penentuan Cut off Point Individu Ver.Hs1 xdsx - Excel

AU Inset  Pagelayout  Formulas  Data  Review  View  Help Q' Tell me whatyouwantto do
o ¥ _ = =S
2 Calib 2 - === ®- [ WapTex General B = 4 d | gm BX p
DE@v alibri A A = ¥ 2 WrapTet | General = 2 s &5 = z- Z'Y
Paste & u S A-| === =52 ElMergefiCemer - - % » 3 £ Conditional Formatas Cell | Insert Delste Format _ Son& Find&
Formatting+ Table~ Stylesw | + v v Filter = Select~
Clipboard 1 Font F] Alignment F] Number F] Styles Cells Editing A~
Ad e 23 No v
A B < ] E F & H 1 J K [a
1 |DATA INDIKATOR INDIVIDU FSVA-Desa 2019
2 KabfKota:
5
1. Rasic luas lahan baku 2. Rasio Jumlah sarana 3. RasioImlh 4, = iki 5. 6. Rasio.
No. Mama Kecamatan Nama Desa/ Kelurahan = =zwshterhadapluas rerendan o L
Kelurshan e (Desil 1) mamszdsi \p tingkat
o - - - - 1= - rumahtangea  — penduduk |~ |  atauairatauudara rumahtangga  ~  kepadatan penduduk
5
&
7
s
3
10
1
2
=
14
15
i
T
pt 3
15
»
21
2
3
=
25
26
27
=
2
30
a1 -
» Data FSVA Kab 2019 1.Rasio Luas Lahan | 2.Rasio Sarana Pangan | 3.Rasio Tidak Sejahtera | | 4. Akses Jalan 5. Rasio Tanpa Air Bersih .. (+) < v
A m - 1 + 0%
—
. y 17:55
- - 2 Ol 5t
z a_‘ F B

Bagian ini untuk mempersiapkan kembali data-data indikator yang
sudah dihitung pada tahap sebelumnya untuk dilakukan proses
pengecekan sebelum melanjutkan ke tahap penentuan cut off point
indikatorindividu pada sheet-sheet disebelah kanan.
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Bagian Sheet Penetuan Cut Off Point Indikator (Arah Positif)

1. Form Penentuan Cut off Point Individu Ver.Hsl xlsx - Excel

Help. Q  Tell me what you want to do

A B C D F G H s J K L M N o P Q R S -~
1. Rasio 1. Rasio
, |uastanan e Ra S G el
2 rhadap Luas Wilayah Desa
3 Min
4 Max 60
5 | Q2(50%)
s |
7 | PosisiRanking  NilaiRasio
k] 15%
9 30%
10 T0%
11 85%
12
13
14
15
16
17
18
19
20
21
22 Prioritas 6
| DataFSVAKab2019 1. Rasio LuasLlahan || 2, Rasio Sarana Pangan || 2. Rasio TidakSejahtera || 4. AksesJalen | 5. Rasio Tanpa Air Bersih ... (+) v
EB m - L + 100%
-

| PM |

Sheet dengantampilan seperti diatas digunakan untuk menghitung cut
off point indikator rasio luas lahan sawah terhadap luas wilayah
(dengan arah persepsi indikator bersifat positif). Artinya semakin
besar nilai rasio suatu wilayah menunjukkan tingkat ketahanan
pangan wilayah tersebut semakin tinggi. Selain indikator ini, ada
indikator rasio sarana prasarana penyedia pangan yang memiliki arah

persepsi yang sama.

Bagian Sheet Penetuan Cut Off Point Indikator (Arah Negatif)

1. Form Penentuan Cut off Point Individu Ver.Hsl xlsx - Excel

Help Q  Tell me what you want to do

Al - # || 3.Rasio Pddk Tidak Sejahtera
A c D E F G H 1 J K L ™ N e] P Q R s T =
3. Rasio 3. Rasio
Pddk Tidak PddkTidak [ Range  Ranking
sejahtera Sejahter - 2 2

Cut Off Point Indikator Rasio Penduduk Tidak Seje t Jumlah Penduduk

1

2

3 Min

a4 Max 3 a0 60 7
s | az2(s0%)

6

7

8 rioritas

15% =
9 30% -<
10| 0% <
11 8% <
12 -<
13 <
14
15
16
17
18
19
20
21
22

ra_| 4.AksesJalan | 5.Rasio Tanpa AirBersih 6. Rasio Pddk per Tenk ... (& >

3] o = 1 + 100%

——
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Bagian ini digunakan untuk menghitung cut off point indikator rasio
penduduk dengan tingkat kesejahteraan terendah, desa tanpa akses
penghubung yang memadai, rasio rumah tangga tanpa akses air
bersih, dan rasio penduduk per tenaga kesehatan terhadap tingkat
kepadatan penduduk (dengan arah persepsiindikatorbersifat negatif).
Artinya semakin besar nilai rasio suatu wilayah menunjukkan tingkat
ketahanan pangan wilayah tersebut semakin rendah.

2.Form_ Analisis FSVA Kab 2019 Ver.Hsl digunakan untuk
melakukan proses penyamaan persepsiindikatorpada rasio luas lahan
baku sawah dan rasio sarana prasarana penyedia pangan. Selain itu
form ini juga digunakan untuk merangkum informasi cut off point
indikatorindividu yang sudah didapatkan pada form sebelumnya.

Form analisis ini merupakan form utama untuk menentukan cut off
point indikator komposit, menghitung indeks komposit pada masing-
masing wilayah (desa), dan mengelompokkan wilayah kedalam
prioritas rentan atau tahan. Tampilan form analisis bisa dilihat pada
gambar dibawah:

Bagian Data & Entry Bobot

2. Form Analisis FSVA Kab 2019 Ver.Hsl xlsx - Excel

Help @ Tellme what you want to do

- 21 N
=_— ®-  2®wapTet General - ’;‘J S‘J o E)& @ z. éY /O
B IU- - H-A- === =35= EMege&Center - | [~ % » %8 £ Conditional Formatas Cell | Insert Delete Format _ Sort& Find &

- Formatting= Table= Styles~ | - - - Filter~ Select -
Clipboard = Font ® Alignment ® Number ® Styles Cells Editing -~

| e c
+ | Data Indikator 2019

2| Fand Security ond Vulnerabilty Atios (F5VA-Desa)
B

2 Kabupaten/ Kota :

L
sawahs uzs 3
e a0 as miat
wiayal ang; * a me: n
B e
Kode Desa/
Ho. Nama Kecamatan Kode Kec Hama Desa/ Kelurahan 1. Rasio Lahan 2. Rasio Sarana
s i1 Kelurahan

BLEWE RS

BNEMENEE Y

5
4

1. Data 2019 & Entry Bobot || 2. Cut Off Indlividu & Kompesit | 3. Indeks Kemposit 4. Perhitungan Individu @ < v

=

20:05
21/04/2019

ESICTI TR
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Indikator warna kuning merupakan kolom proses penyamaan persepsi
indikator. Karena keempat indikatoryang lain mempunyai arah negatif
maka kedua indikator tersebut perlu disamakan persepsinya.

H - B - 2. Form Analisis FSVA Kab 2019 VerHsL s - Excel "5 -
Insert  Pagelayout  Formulas Data  Review  View  Help Q  Tell me what you want to do 5 Share -]
L X . .| = [==] [ 3 - A
Calibri -l -A A= Bre 20 Wrap Text General - = } gm Bx @ p
D - P B3] 2 B o . ZY
Paste Blrou- . erge & Center = | 7+ 95 3 % 8§ | Conditional Formatas Cel | Insert Delete Format | Sort& Find &
- Formatting = Table~ Styles - - - - &7 Filter - Select -
Clipboard 1= Font & Alignment = Number = Styles Cells Editing ~
A6 - ¥ || No. v
A 5 | ¢ | L) I E I 2 I L3 | L I L] LT o | L3 | a | E
. |Data Indikator 2019
2| Fond security ond vulnerabilty Atios [FsvA-Desa)
5 ]| AKSES PANGAN PEMANFAATAN PANGAN
- DTPPEM [SK.71/2018) - DTPPEM (SK.71/2018) - Podes 2018
2 _ Trroveksipadzos e TProvRTIHE | Pk
B Penyamsanersspsi  LRmomnRdk  4Dsspangiik Lo 6 Raseumn
tangga tanps sksms gy | PETOUOUk perEnaga
penyedz . per i N"f‘;mm"; oy | kesehatantehadap
pengantenadapjumish  terhagspjumish memyigmtamuEe | o o P tingkst kepadatan
s rumsh tangga penduduk stauuders rumantnzss penduduk
o Mo, ‘Nama Kecamatan Kode Kec 2. Rasio Sarana ‘BOBOT INDIKATOR
7 1, Rasio Lahan
5| 2. Rasio Sarana
s | 3. Rasio Pk Tidsk sejahtera
] 2. Akses aban
1| 5. Rasio Tanga Air Bersih
2| 6. Rasio pdk per Tenkes per Density
5
iy
|
5| Xeteransan:
| sotot v pess 201
)
19| Bobor Indikatar
0| 0,17 1. Rasio Lahan
| 037 2. Rasiosarans
| 017 3. Rasio Podk Tidsk Sejahtera
2| 0,17 4. Akses salan
2| 0,17 5. Rasin Tanpa Air Bersih
| 037 6. Rasio POk par Tenkes par Dansty
28|
Ed -
1. Data 2019 & Entry Bobot | 2. Cut Off Individu & Komposit | 3.Indeks Komposit | 4. Perhitungan Individu | () 0

Scroll Lock

2. Form Analisis FSVA Kab 2019 Ver.Hsl xisx - Excel = -

Qsmae @

Formulas  Data Review  View  Help Q  Tell mewha want to

= o= = B
o LS Calibri -lu -l = 20 Wrap Text General - 2] &= %( E = ‘QY p
B - 7 =z -
Paste B I u- - crge & Cemter - | T 95 5 4 g3 | Conditional Formstss Cell | Insert Delete Format _ sorta Find &
Formatting~ Table~ Styles - - - @ = Filter~ Select -
Clipboard 1 Font 5 Alignment = Number 5 Styles Cells Editing ~
AL - 5 -

2. Rasio Sarana

Arch Positif (+) Arah Positif (+)

Prioritas 3
Prioritas 4
Prioritas 5
Prioritas 6
PRIORITAS SKOR KOMPOSIT (Z_Scale)

PRIORITAS b i
Prioritas 1 >=

Prioritas 2

Prioritas 3

Prioritas 4

Prioritas 5

Prioritas 6

Prioritas 1
Prioritas 2
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2. Form Analisis FSVA Kab 2019 Ver.Hsl xlsx - Excel

Pagelayout  Formulas  Data  Review  View Help Q' Tell me what youwantto do 5 share ®

ol o o fee) [P .
N % Calibri TR - 2 Weap Tedt General - 7] } &= %( @ = '%‘Y p
B - =
Paste o B 1 u- - D-A- Merge & Center - | (%< 0 » %3 83 Conditonsl Formatss Cell | Insert Delete Format | sort& Find&
- Formatting = Table~ Stylesw |+ v - Filter - Select -
Clipboard 1 Font ~ Alignment & Number & Styles Cells Editing ~
a1 - £ v

Untuk dua baris yang
FRIORITAS berwana pink silahkan cek

Milgi Mox Z Scole

prioftas 1 - - - - - - dengan aturan:
Frortasz - - - - - -
Frioritas 3 - - - - - -
Prioritas 4 - - - - - -
Prortass - - - - - -
Frormass - - - - - .

1. Jika baris ke-2 (warna
pink) masih bernilai sama
dengan baris ke-1 atau nilai
sastan baris ke-2 lebih besar dari ooy
PRIORITAS 100, maka perlu ada proses
l:::: penyesuaian nilai di baris -
yang berwana hijau. - - -

Priortas2 - - - - B B
Priortas 3 - - - - - -
prioftasa - - - - - -
Prortass - - - - - -

2. Penyesuaian nilai di
baris hijau berdasarkan
lebar selang yang sering
muncul

BAGIAN |

| 1. Data 2019 & Entry Bobot | 2. Cut Off Individu & Komposit | 3.Indeks Komposit | 4. Perhitungan Individu | (5 O ——

Scroll Lock

3 5 oL ] —

Digunakan untuk melakukan pengecekan dan penghitungan cut off
point indikator komposit.

Bagian Sebaran Wilayah Berdasarkan Indeks Komposit

H ©- @ - 2. Form Analisis FSVA Kab 2019 Ver.Hsl xisx - Excel Sign in =

Insert  Pagelayout  Formulas Data  Review  View  Help ' Tell me what you want to do 5 Share @

= o = P .
N * | ot BT e 2 WeapTet General - 7] } & E‘X @ b3 '%Y p
EE o~
Paste B rou- . Merge & Center = | [« 95 5 4§ g3 | Conditional Formatas Cell | Insert Delete Format Sort & Find &
- Formatting = Table~ Styles - - - - @~ Filter- Select~
Clipboard s Font ] Alignment i) Number i) Styles Cells Editing ~
A6 - I No. v

2 s

1 Ketersedigan Abses. Pemanfaatan
2 | PERHITUNGAN INDEKS KOMPOST ‘Bobot Indikator - - - - - -
3 | pimtos wileyah (Desc) Maan - - - - - -

a| ‘Standar Deviasi - - - - - -
s

T| R
B EEan e ]

E‘E,E"6‘EIE,E‘G‘G,E,E‘E‘KIE,W‘W"‘ o

\Ell\;\k

| 1.Data2019 &EntryBobot | 2. Cut Off Individu & Komposit 3. Indeks Komposit a,

Scroll Lock

s Shage s - L
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Bagian ini untuk melakukan perhitungan indeks komposit pada
masing-masing wilayah desa dengan menggunakan standarisasi dua
tahap (Z-Score dan Scale). Selain itu cut off point indeks komposit
juga terihat seperti gambar dibawah.

2. Form Analisis FSVA Kab 2019 VerHsL s - Excel

Insert  Pagelayout  Formulas Review  View Help Q' Tell me what you wantto do

-, .| = T B I | 2 A
ln - S== - @ . J | = B El p
DE@- Calibri 1 K A = ® 2 Wrap Text General g) 5 ) A d
Paste Bl:u-|5- oA =B= Merge & Center -+ | T« 95 5 %3 9§ Conditional Formatas Cell Insert Delete Format | Sort& Find &
- Formatting = Table~ Styles~ - - - 7 Filter - Select -
Clipboard 1= Font & Alignment & Number & Styles Cells Editing ~
AB e 5 No. A
A 5 c o e ™ N o 3 a R s T u v w x| v z A 28 ry
1
2 [PERHTUNGAN INDEKS KOMPOST ‘Bobot Indikator
3| Dimtasing masing wilayah fpess) Mean Kab/Kota:
2 Standar Deviasi
s INDEKS KOMPOSIT
cuT oFF sKOR
o | nama odenec Kode Desa/ Nama Desa/ PRIORITAS INDEKS o ome | PRIORTIS
HeEmaEr Kelurahan Kelurahan KowposT  komposT T B i KxompasiT
e - - - - - - -
Z - prioritas 1 - Prioritas 1 <= -
5 Prioritas 2 - Prioritasz | > - - -
B prioritas 3 - prioritass | > - —I
) prioritas - prioritasa | » - — -
) prioritas’s - priortass | > - -
z Prioritas & - Prioritas & > -
=
n
=
1
a7
5
)
7]
2
2
=
7}
2
2
2
=
)
0
E
2 - - - -
‘ 1. Data 2019 & Entry Bobot ‘ 2. Cut Off Individu & Komposit 3. Indeks Kompaosit ‘ 4. i Individu | ® 4 v

Scroll Lock

2, Form Analisis FSVA Kab 2019 Ver.Hsl xlsx - Excel

Formulas  Data  Review  View  Help Q  Tell me what you want to do

- 2 Wrap Tet General -

Y oo [ .
0 &* Calibri S TR o ‘, Q £ EEIEEX El é QY p

By -
Merge 8 Center - | 7 95 » %3 83 Conditonal Formatas Cell | Insert Delete Format Sort & Find &
Formatting = Table~ Styles~ - B - 7 Filter~ Select -

Past : —E=
e ¢ BIU- - O-A- ===
Clipboard = Font & Alignment 5 Number 5 Styles Cells Editing ~

AB e 5 No. v

s . c o 3 e " \ s « L
il SEBARAN PRIORITAS DESA BERDASARKAN INDIKATOR INDIVIDU & KOMPOSIT FSVA KABUPATEN 2019
2 [PERRITUNGAN FRIORITAS INDIKATOR INDIVIDU Kab/Kotas

3 | pimasi ing wil

g Ketersediaan Akses Pemanfaatan

s
Kote Desaf Nama Desa/ . . PRIORITAS
ST = T ZWEW'E““"N: - = I

Prioritas 1
Prioritas 2
Prioritas 3.
Prioritas
Prioritas 5.
Prioritas 6

HERSEEEE SRR

| 1.Data2019 &EniryBobot | 2. Cut Off Individu & Komposit | 3. Indeks | 4. Perhi Individu | @ v v

Scroll Lock
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Digunakan untuk mengelompokkan suatu wilayah kedalam prioritas
rentan atau tahan berdasarkan cut off point masing-masing indikator
individu. Sehingga nanti akan terlihat bagaimana sebaran wilayah
pada masing-masing indikatorindividu. Selain itu pada sheet tersebut
juga dilengkapi prioritas komposit masing-masing wilayah (desa).

Pada sheet tersebut juga dilengkapi bagian yang merupakan
rangkuman cut off point indikatorindividu dan komposit sebagai dasar
pengelompokan suatu wilayah masuk prioritas rentan atau tahan
sepeti tampilan gambar berikut:

1. Rasio Lahan 2. Rasio Sarana
arah [+ arah [+)

Prioritas 1
Pripritas 2
Prioritas 3
Prioritas 4
Pripritas 5
Prioritas 6

CUT OFF INDIKATOR INDIVIDU

[ R T

2.2 Persiapan Analisis Data

» Menyiapkan Form Analisis FSVA Kabupaten dan Data
Mentah Indikator FSVA

Sipakan Form Analisis FSVA Kabupaten 2019 dengan cara meng-
copy form yang sudah disediakan ke Desktop sehingga muncul
tampailan seperti gambar dibawah ini:
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Setelah itu siapkan data 6 indikator FSVA dalam format excel. Misal
data yang digunakan adalah Data Indikator FSVA Kab Aceh Singkil
Cari data di D:\Pelatihan Komposit FSVA Kabupaten\Data Indikator
FSVA Kab Aceh Singkil. Kemudian copy file data excel tersebut ke
dalam folder Form Analisis FSVA Kabupaten 2019.

Sehingga didalam folder Form Analisis FSVA Kabupaten 2019
menjadi empat file excel yaitu: 0.Form Validasi Data & Hitung
Indikator Ver.Hsl; 1.Form Penentuan Cut off Point Individu
Ver.Hsl; 2.Form Analisis FSVA Kab 2019 Ver.Hsl1; dan tambahan
file data mentah indikator Data Indikator FSVA Kab Aceh Singkil
seperti tampilan gambar berikut:

I IM | > Form Anaisis F5Vik Kabupaten 2015

File Edit View Tools Help
Sharewith v Print  E-mai Bum  New folder =~ [ @

licdasi Data & Hitung Indikator Ver.Hsl xlsx
nentuan Cut off Point Individu Ver Hslxlsx

alisis FSVA Kab 2019 Ver.Hs1.xlsx
ator FSVA Kab Aceh Singkilaxsx

- BOOTCAMP (C1)
L3 CD Drive (D)

- Macintosh HD (E:)
(. Galaxy A3 2016

i Network

s Title: Add a title Tags: Add a tag Content status: Add text
Authars: B

K

Kemudian ganti nama folder Form Analisis FSVA Kabupaten 2019
menjadi Analisis FSVA Kab. Aceh Singkil 2019. Sehingga tampilan
folder pada Desktop seperti gambar dibawah:
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> Membuka Data Mentah Indikator FSVA Kabupaten

Buka file Data Indikator FSVA Kab Aceh Singkil sehingga muncul
tampilan data seperti berikut:

g - Data Indikator FSVA Kab Aceh Singkil sk - Excel

Insert  Pagelayout  Formulas Data  Review  View Help Q' Tellme whatyouwantto do

.y PR - [==] =" -
0 ;;‘ Calibri S oea s SEo - B wepTet Number - Q‘ D &= Ex El Z‘ Q\Y p
paste Blrou- - erge @ Center = | 07+ 95 %3 83 Conditional Formatas Cell | Insert Delete Format | Sort& Find&
- Formatting~ Table= Styles~ | - - - Filter~ Select -
Clipboard 1 Font & Alignment @ Number @ Styles Cells Editing ~
A3 - £ | No. v
A = < o e F s " ' s K . M N o P
1 SumberData | BPS, Pusdatin BPS, Pusdatin | Podes2018  DTPPFM (SC.71/2018) Podes2018  DTPPFM (SK.71/2018) Podes2018 | ProyeksiSP2010 | ProyaksiSP 2010
2
3.Jmlh Pddktingkat 4. Desayang 5.Jmlh RT dengan &.Jumlah
No. |Provinsi Kabupaten  Kecamatan Desa Kode Desa keszjshtarsan  tidakmemilisi  sumber airminum T
3 ~- - - - hd ~ | terendah [Desil T akses | ™| TidakTerlindun ¥ | kesehata ¥ 2018 || Tenesa20i8 .
4 1 ACEH ACEH SINGKIL PULAU BANYAK PULAU BAGUK 1102010003 0,00 555 42 552 4 167 5 1601 397
s 2 ACEH 'ACEH SINGKIL PULAU BANYAK. PULAU BALAI 1102010004 | 0,00 344 44 583 4 194 17 1.895 401
6| 3 ACEH  ACEHSINGKILPULAUBANYAK  TELUKNIBUNG 1102010005 0,00 ass 2 540 s 117 1 1120 258
7 4 ACEH ACEH SINGKIL PULAU BANYAK BAR. ASANTOLA 1102011001 0,00 6302 15 315 1 122 2 804 204
8 5 ACEH ACEH SINGKIL PULAU BANYAK BAR. UJUNG SIALIT 1102011002 0,00 533 11 563 4 9 2 1031 261
5| & |ACEH | ACEHSINGKILPULAUBANYAK BAR HALOBAN 1102011003 000 19.453 19 450 1 147 5 921 234
0w 7 ACEH ACEH SINGKIL PULAU BANYAK BAR. SUKA MAKMUR 1102011004 | 0,00 1308 2 183 4 43 1 384 9
u 8 ACEH ACEH SINGKIL SINGKIL PULO SAROK 1102020003 0,00 1.061 131 303 1 56 56 4.265 1.047
12| 5 ACEH  ACEWSINGKILSINGKIL PASARSINGKIL | 1102020004 000 501 34 130 1 1 5 1534 376
13 10 ACEH ACEH SINGKIL SINGKIL UJUNG 1102020005 0,00 563 &3 379 1 &9 1 2.164 541
14| 11 ACEH  ACEWSINGKILSINGKIL KOTASIMBOLING 1102020008 o0 & s 7 2 15 1 323 7
15 12 ACEH ACEH SINGKIL SINGKIL KILANGAN 1102020007 0,00 1122 7 237 1 15 5 1870 380
1% 13 ACEH 'ACEH SINGKIL SINGKIL TELUK AMBUN 1102020009 0,00 33 7 253 3 122 1 884 215
17| 16 ACEH  ACEWSINGKILSINGKIL RANTAUGEDANG 1102020010 0,00 1679 0 335 2 120 1 617 197
13 15 ACEH ACEH SINGKIL SINGKIL TELUK RUMBIA 1102020011 0,00 6534 15 486 2 167 1 882 152
13 16  ACEH ACEH SINGKIL SINGKIL TAKAL PASIR 1102020012 0,00 1.647 20 203 1 111 1 599 153
20| 17 ACEH  ACEMSINGNILSINGKIL seLok AceH 1102020013 000 1934 12 18e 1 2 2 es3 157
P2y 18 ACEH ACEH SINGKIL SINGKIL PEABUMBUNG 1102020014 | 0,00 2.757 ] 183 2 20| 1 520 125
22| 13 ACEH  ACEMSINGKILSINGKIL PEMUKA 1102020015 o0 308 3 230 1 81 1 383 51
2 20 | ACEH ACEH SINGKIL SINGKIL SUKA DAMAI 1102020019 0,00 743 7 374 1 128 2 853 184
Pl 21 ACEH 'ACEH SINGKIL SINGKIL UJUNG BAWANG 1102020020 0,00 538 10 352 2 82 4 997 218
25| 22 ACEH  ACEMSINGHILSINGKIL smamBia 1102020021 0,00 183 0 335 2 5 1 133 a11
26 23 ACEH ACEH SINGKIL SINGKIL SUKAMAKMUR 1102020022 0,00 170 13 209 2 57 4 723 166
pil 24 ACEH ACEH SINGKIL SINGKIL UTARA. GOSONGTELAGAL 1102021001 0,00 25 2 224 1 42 1 1290 268
28| 25 ACEH  ACEMSINGKILSINGKILUTARA  GCSONGTELAGAS 1102071002 0,00 1121 7 348 1 2 1 995 212
pa) 26 ACEH ACEH SINGKIL SINGKIL UTARA GOSONGTELAGAT 1102021003 0,00 107 16 480 1 83 2 1451 304
n 27 | ACEH ACEH SINGKIL SINGKIL UTARA. TELAGA BAKTI 1102021004 | 0,00 15.280 15 43 2 4 5 1879 474
31| 28 ACEM | ACEHSINGKILSINGKILUTARA  KAMPUNGBARU 1102071 0,00 924 3s 362 1 3 10 1504 a1 -

Draft Data FSVA Kab 2019 @® ] »

Check lagi apakah data mentah untuk masing-masing indikator sudah
terisi semua. Lakukan proses cleaning data dengan cara melihat
distribusi data mentah untuk masing-masing indikator. Apabila ada
suatu distribusi data yang tidak normal maka perlu di cek kembali dan
apabila diperlukan dapat dilakukan penyesuaian (adjustment) data
sebelum dilakukan proses lebih lanjut.

2.3 Input Data Mentah di Form Validasi

Buka 0.Form Validasi Data & Hitung Indikator Ver.Hsl untuk
melakukan input data mentah indikator ketersediaan pangan, akses
pangan dan pemanfaatan pangan. Selain untuk input data, form ini
juga digunakan untuk memvalidasi data jika ada data pembanding dan
sumber yang lain.
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0. Form Validasi Data & Hitung Indikator Ver.Hsl.xlsx - Excel

Review  View Help Q' Tell me what youwant to do
Y — f==] 1= .
D;;i. Caliori n KA SEZ @ |[BWeptet General B EJ D.J & EX ] é. Ay ,O
Paste B I Uu- - HoA- === == EMegefCeter - - % 5 5§ #f  Conditional Farmatas Cell Insert Delete Format _ Sort& Find &
- Formatting = Table~ Styles - - - Filter = Select -
Clipboard 1 Font ] Alignment ] Number ] Styles Cells Editing ~
A6 - £ || No v
|mar] ) < D E F G H 1 J K L M N -
1 |VALIDAS| DATA INDIKATOR KETERSEDIAAN Kabupaten/ Kota :
2 | Food Security and Vuinerability Atigs (FSVA-Desa) 2019
3
Pusdatin- . et
Sumber 8PS Dinas Validasi KESEPAKATAN Podes 2018 8PS q
4 Kementan
s Tahun 2012 2018 2012 2018 2012 1
Kode Desa/ Nama Desa/ 1. Luas Lahan Liussishan  Llussishan  1lusslanan - Do VaE Keterangan Luas 2 umiah Sarana Z. jumiah Sarana & 2. Jumi
Mo, Nama Kecamatan Kode K Kelurahan Keluraan Saman Sawan Sawah saman | DibakaidiFsva O R & Prasarana Prasarana Pre
(3] (R (Km2) Penyedia Pangan Penyedia Pangan  Penye
7
8
9
10
11
12
13
14
15
16
17
18
19
20
2
2
23
2
= -
1. Indikator Ketersediaan || EAMGIBGHAGERBAGaN | 3. maikator pemantaatan IRl ISR GG < :
i) m - I + B80%

27
22/04/2019

¥9 "W e = BN

A T

C

3
-

Cell warna kuning digunakan sebagai tempat menginput data. Namun
tidak semua cel/l warna kuning harus diisi, karena tergantung
ketersediaan data pembanding yang dimiliki oleh masing-masing
daerah. Yang perlu diisi dan tidak boleh kosong adalah cell yang
berwarna hijau, karena cell tersebut dijadikan dasar untuk
menghubungkan dengan cell-cell yang lain.

Kemudian lakukan input data pada cell yang berwarna kuning dan
hijau berdasarkan Data Indikator FSVA Kab Aceh Singkil yang
sudah dibuka tadi. Input data sebaiknya dilakukan secara hati-hati
dengan menyesuaikan antara judul kolom Form Validasi dengan judul
kolom pada Data Indikator.

Lakukan input data pada sheet Indikator Ketersediaan terlebih
dahulu, sehingga jika sudah selesai terinput maka tampilan form akan
berubah seperti gambar dibawah ini:
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0. Farm Validasi Data & Hitung Indikator Ver HsLadsk - Excel

Formulas  Data  Review  View Help Q' Tell me what youwant to do

21
Calibri MV 2D Wrap Text General - ’_:.‘d Q %ﬂ %X @ b3 : Q‘Y p
B rou- - Merge & Center - | [0+ 9 5 % 3 Conditional Formatas Cell | Insert Delete Format | Sort& Find &
Formatting - Table~ Styles - - - - ¥ Filter - Select
Clipboard & Font & Alignment & Number & Styles Cells Editing ~
A6 2 £ | No. v
A B c D E 3 G H 1 ) K L M N =
1 VALIDASI DATA INDIKATOR AN f Kota: ACEH SINGKIL
2 |Foou Security ana Vuineraitity Atios (FSvA-Desa) 2019
3
Sumber Pusdatin- 8ps Dinas Validasi | KESERAKATAN Podes 2018 8PS
4 Kementan
5 Tahun —20lS 2018 2018 2018 2012
o e rare Kode Desa/ Nama Desa/ 1. Luas Lahan -lugslahan  1.luaslahan  1.LuasLahan| D.:;;‘:'fﬁ,:’;fm Keferangan Luas 2':::::““ 2'"$:::ﬁ“" 2'":
5 Kelurahan Kelurahan sawan sawan sawah sawan (Kkm2) PanSaWan - penyedia Pangan Penyedia Pangan  Penye
7| 1 PULAU BANYAK 1102 1102010003 PULAU BAGUK 0,00 0,00 a2
5| 2 PULAUBANYAK 1102 1102010002 PULAU BALAI 0,00 0,00 a
9| 3 PULAU BANYAK 1102 1102010005 TELUK NIBUNG 0.00 0.0 2
10| 4 PULAUBANYAKBARAT 1102 1102011001 ASANTOLA 0,00 0,00 15
11| 5 PULAUBANVAKBARAT 1102 1102011002 UIUNG SIALIT 0,00 0,00 1
12| 6 PULAUBANYAKBARAT 1102 1102011003 HALOBAN 0,00 0,00 19
13| 7 PULAUBANYAKBARAT 1102 1102011002 SUKA MAKMUR 0,00 0,00 2
14| 8 siNeKIL 1102 1102020003 PULO SAROK 0.00 0.0 131
15| 9 siNgKIL 1102 1102020002 PASAR SINGKIL 0,00 0,00 32
16| 10 SINGKIL 1102 1102020005 UIUNG 0,00 0,00 63
17| 11 sinekiL 1102 1102020006 KOTA SIMBOLING 0,00 0,00 H
18| 12 sINGKIL 1102 1102020007 KILANGAN 0,00 0,00 7
19| 13 sineKiL 1102 1102020009 TELUK AMBUN 0.00 0.0 7
20| 14 siNGKIL 1102 1102020010 RANTAU GEDANG 0,00 0,00 20
21| 15 siNeKIL 1102 1102020011 TELUK RUMBIA 0,00 0,00 15
22| 16 siNeKIL 1102 1102020012 TAKAL PASIR 0.00 0.0 %)
23| 17 singKIL 1102 1102020013 SELOK ACEH 0,00 0,00 12
22| 18 sINGKIL 1102 1102020014 PEA BUMBUNG 0,00 0,00 3
25| 19 siNeKIL 1102 1102020015 PEMUKA 0,00 0,00 3 -
Lot Ketersedinon |2 netor A PR inindimbonianbocton Csifugngier | : :

Lakukan langkah input data yang sama untuk sheet Indikator Akses
Pangan dan Indikator Pemanfaatan. Setelah input data dilakukan,
maka tampilan kedua sheet akan berubah seperti dibawah:

Tampilan sheet Indikator Akses Pangan setelah terinput data.

0. Form Validasi Data & Hitung Indikator Ver.HsLudsx - Excel Sign in 3l

View Help @ Tellme what youwantto do

bl .
0 % Calibri Tl oA A 2 Wrap Text General M i ]
By -~
Paste B rou- . Merge & Center = | [« 95 5 4§ g3 | Conditional Formatas Cell | Insert Delete Format Sort & Find &
- Formatting - Table~ Styles~ - - - &7 Filter~ Select -
Clipboard s Font [ Alignment [ Number [ styles Cells Editing ~
A6 & A | No. v
A ] c D 3 3 G H 1 ] K L =
1 |VALIDASI DATA INDIKATOR AKSES PANGAN Kabupaten/ Kota : |ACEH SINGKIL
2 |Food Security and Vulnerability Atlas (FSVA-Desa) 2019
3
Sumber DTPPEM ($K.71/2012)- BPS Dinas Validasi KESEPAKATAN Pod
il
5 Tahun 2018 2018 2018 2
o Noma (ec Kote Desa/ Nama Desa/ 3 Tingkat | 3. Tingkat 3. Tingkat 3. Tingkat] :' Da’":_m Keterangan Pddk 4. Desa
. ecamatan ode Kelurahan Kelurahan j Terendah: i Terendah i Terendah j Terendalf ’a'::_' ',m"‘ tescjateraan Terendah  Penghubu
jwa)
7| 1 PULAUBANYAK 1102 1102010003 PULAU BAGUK S 552
8| 2 PULAU BANYAK 1102 1102010004 PULAU BALAI 58: 583
9| 3 PULAUBANYAK 1102 1102010005 TELUK NIBUNG E 540
10| 4 PULAUBANVAK BARAT 1102 1102011001 ASANTOLA 31 315
11| 5 PULAUBANYAK BARAT 1102 1102011002 UJUNG SIALIT 56: 563
12| 6 PULAUBANYAK BARAT 1102 1102011003 HALOBAN 25 250
13| 7 PULAUBANYAK BARAT 1102 1102011004 SUKA MAKMUR 1 169
12| B SINGKL 1102 1102020002 PULO SAROK 30: 303
15| 8 sINGKIL 1102 1102020004 PASAR SINGKIL 129 140
16| 10 SINGKIL 1102 1102020005 UIUNG 37 379
17| 11 SINGKIL 1102 1102020006 KOTA SIMBOLING 74 7
18| 12 SINGKIL 1102 1102020007 KILANGAN 237 237
19| 13 SINGKIL 1102 1102020008 TELUK AMBUN 25 253
20| 14 SINGKIL 1102 1102020010 RANTAU GEDANG 3 345
21| 15 SINGKIL 1102 1102020011 TELUK RUMBIA 8¢ 486
22| 16 SINGKIL 1102 1102020012 TAKAL PASIR 20: 203
23| 17 SINGKIL 1102 1102020013 SELOK ACEH 184 184
24| 18 SINGKIL 1102 1102020014 PEA BUMBUNG 18 189
25| 19 SINGKIL 1102 1102020015 PEMUKA 234 234 -
| = : e
Select destination and press ENTER or choose Paste i) m - 1 + B0%
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Tampilan sheet Indikator Pemanfaatan setelah terinput data.

0. Form Validasi Data & Hitung Indikator Ver Hsl.udsx - Excel Sign in |

Formulas  Data  Review View Help @ Tellme what youwantto do

s
Calibri 20 Wrap Text General - I::'—‘ Q Q %ﬂ %X @ = : ‘%Y p
B rou- i [ Merge & Cemter - | ©0- 9 » 8 28 Conditional Formatas Cell | Insert Delste Format Sort & Find &
- Formatting = Table~ Styles~ - - - " Filter~ Select~

Clipboard 1% Font ] Alignment ] Number ] Styles Cells Editing ~
AB 2 B | No. v

A 8 c D 3 F G H 1 1 4 L [~
1 |VALIDASI DATA INDIKATOR PEMANFAATAN PANGAN Kabupaten/ Kota : ACEH SINGKIL
2 | Food Security and Vulnerability Atias (FSVA-Desa) 2019
3

Sumber Data Dasar DTPPFM (8K 71/2013)- BPS. Dinas Validasi KESEPAKATAN
4
= Tahun 2012 2018
:| e Kode kee ode Desa/ Nama Desa/ 5. lumizh RT dengan Sumber 6. Jumiah R dengan Sumber 5. Jumian RT 5. Jumiah RT d_:)‘ﬂ'::_:‘:ﬁﬁn 6.

5 Kelurahan Kelurahan Air Minum Tidak Terfindung | Air Minum Tidak Terlindung  Air Minum Tidak Terlindung  Air Minum Tidak Terlindung - NoWater
7| 1PULAUBANYAK 1102 1102010003 PULAU BAGUK 167 167
8| 2 PULAU BANYAK 1102 1102010004 PULAU BALAI 184 194
9 | 3 PULAUBANYAK 1102 1102010005 TELUK NIBUNG 17 17
10| 4 PULAU BANYAKBARAT 1102 1102011001 ASANTOLA 122 122
11| 5 PULAUBANYAK BARAT 1102 1102011002 UJUNG SIALIT 9 )
12| 6 PULAU BANYAK BARAT 1102 1102011003 HALOBAN 147 147
13| 7 PULAU BANYAK BARAT 1102 1102011004 SUKA MAKMUR 23 a3
14| 8 sINGKIL 1102 1102020003 PULO SAROK 56 56
15| 9 siNeKIL 1102 1102020004 PASAR SINGKIL 1 1
16| 10 SINGKIL 1102 1102020005 UJUNG 69 69
17| 11 sINGKIL 1102 1102020006 KOTA SIMBOLING 15 15
18| 12 sINGKIL 1102 1102020007 KILANGAN 15 15
19| 13 sINGKIL 1102 1102020008 TELUK AMBUN 122 122
20| 14 sINGKIL 1102 1102020010 RANTAU GEDANG 124 124
21| 15 SINGKIL 1102 1102020011 TELUK RUMBIA 167 167
22| 16 SINGKIL 1102 1102020012 TAKAL PASIR 111 m
23| 17 siNeKIL 1102 1102020013 SELOK ACEH a a2
21| 18SINGKIL 1102 1102020014 PEA BUMBUNG 20 20
25| 19 sINGKIL 1102 1102020015 PEMUKA 81 81 -

2.4 Input Data Pendukung di Form Validasi

Data Pendukung yang perlu diinput dan divalidasi adalah data Luas
Wilayah Desa, Jumlah Penduduk Desa, dan Jumlah Rumah Tangga.
Lakukan input data dengan cara copy-paste dari Data Mentah
Indikator ke sheet Data Pendukung pada Form Validasi.

0. Form Validasi Data & Hitung Indikator Ver.HsLadsk - Excel

Help Q  Tell me what you want to do

&D g" | [cotibn i - A AT 25 Wrap Text General - Q 7] == EE"X E E : }Z\Y p
paste 87 u- - Merge & Center - | [0~ 95 » | % 9§ | Conditional Formatas Cell Insert Delete Format T sona Finda
- Formatting = Table™ Styles~ - - - Filter - Select -
Clipboard 2 Font = Alignment © Number = Styles ceiis Editing ~
6 - £ | No. v
A F c o e 3 G H ' ) K L m N -
1 [VALIDASI DATA PENDUKUNG Kabupaten/ Kota : ACEH SINGKIL
2 |Food Security and Vuinerability Atios (FSVA-Desa) 2019
3
Pusdatin- § .
Sumber Data Dasar 8PS Dinas validasi KESEPAKATAN Proyeksi 8PS
a Kementan
Tahun 2018 2018 2018 2018 2018
Kode Desaf Nama Desa/ a.luasWilayah  a.luasWilayah a.luasWilayah a.luasWilayah > DZ12Y2ME  yoraangan b. Jumian b. Jumian b.
| Mo | MemaMecamatanedeKet yoianan Kelurahan Desa Desa Desa Desa dipakel VA Luas wilayan Penduduk Desa  Penduduk Desa  Pendt
7 | 1 PULAU BANYAK 1102 1102010003 PULAU BAGUK
8| 2 PULAU BANYAK 1102 1102010004 PULAU BALAI
2| 3 PULAU BANYAK 1102 1102010005 TELUK NIBUNG
10| 4 PULAU BANYAK BARAT 1102 1102011001 ASANTOLA
11| 5 PULAU BANYAK BARAT 1102 1102011002 UIUNG SIALIT
12| 6 PULAU BANYAK BARAT 1102 1102011003 HALOBAN
13| 7 PULAU BANVAKBARAT 1102 1102011004 SUKA MAKMUR
18| & siNGKIL 1102 1102020003 PULO SAROK
15| 8 siNeKL 1102 1102020004 PASAR SINGKIL
16| 10 SINGKIL 1102 1102020005 LIUNG
17| 11 siNGKIL 1102 1102020006 KOTA SIMBOLING
18| 12 siNGKIL 1102 1102020007 KILANGAN
13 13 siNGKIL 1102 1102020008 TELUK AMBUN
20| 14 sINGKIL 1102 1102020010 RANTAU GEDANG
21| 15 sINGKIL 1102 1102020011 TELUK RUMBIA
22| 16 sinekiL 1102 1102020012 TAKAL PASIR
23| 17 sinekL 1102 1102020013 SELOK ACEH
25| 18 sINGKIL 1102 1102020014 PEA BUMBUNG
25| 13 sINGKIL 1102 1102020015 PEMUKA -
< v

|2 indtor Alses pangan || 3. ndictor 4.0utn 5 Hiung nitor
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Tampilan sheet Data Pendukung setelah terinput data.

0. Farm Validasi Data & Hitung Indikator Ver HsLadsk - Excel

Formulas Data Review View Help

s
&D S; . Calibri 20 Wrap Text General - I::'—‘ g) Q %ﬂ %( @ = : '%‘Y p
Paste B I u- =l Merge & Center - | - 95 s %3 93 | Conditional Formatas Cel Insert Delete Format _ Sort& Find &
- Formatting = Table~ Styles~ - - - Filter = Select =
Clipboard 1% Font ] Alignment ] Number ] Styles Cells Editing ~
AB 2 B | No. v
A 8 [ ¢ | b | 3 F | G | H | 1 | J | K L [ | N | -
1 |VALIDAS| DATA PENDUKUNG Kabupaten/ Kota : ACEH SINGKIL H
2 | Food Security and Vulnerability Atias (FSVA-Desa) 2019
3
Pusdatin- . e .
Sumber Data Dasar B8PS Dinas validasi KESEPAKATAN Proyeksi 8PS
A Kementan
= Tahun e 2018 2012 2018
Kode Desa/ Nama Desa/ . Lugs Wilayah  |a. Luas Wilayah . Luas Wilayah  a. Luss Witayar] - Dota vane
. Mo. | NamaKecamatan  Kode Ker o Desa besa ‘Desa —_ d’ml‘n::; ,FSVA
7| 1PULAUBANYAK 1102 1102010003 PULAU BAGUK 555 555
8| 2 PULAU BANYAK 1102 1102010004 PULAU BALAI 344 384
9 | 3 PULAUBANYAK 1102 1102010005 TELUK NIBUNG 856 856
10| 4 PULAU BANYAKBARAT 1102 1102011001 ASANTOLA 6.302 6.302
11| 5 PULAUBANYAK BARAT 1102 1102011002 UJUNG SIALIT 533 533
12| 6 PULAU BANYAK BARAT 1102 1102011003 HALOBAN 13453 19.453
13| 7 PULAU BANYAK BARAT 1102 1102011004 SUKA MAKMUR 1308 1309
14| 8 sINGKIL 1102 1102020003 PULO SAROK 1.061 1061
15| 9 siNeKIL 1102 1102020004 PASAR SINGKIL 801 801
16| 10 SINGKIL 1102 1102020005 UJUNG 563 563
17| 11 sINGKIL 1102 1102020006 KOTA SIMBOLING 3 8
18| 12 sINGKIL 1102 1102020007 KILANGAN 1122 1122
19| 13 sINGKIL 1102 1102020008 TELUK AMBUN 39 39
20| 14 sINGKIL 1102 1102020010 RANTAU GEDANG 1679 1679
21| 15 SINGKIL 1102 1102020011 TELUK RUMBIA 6.534 6.534
22| 16 SINGKIL 1102 1102020012 TAKAL PASIR 1647 1647
23| 17 siNeKIL 1102 1102020013 SELOK ACEH 1934 1934
21| 18SINGKIL 1102 1102020014 PEA BUMBUNG 2757 2757
25| 19 sINGKIL 1102 1102020015 PEMUKA 308

1 o s g | o 40

Select destination and press ENTER of choose Paste

Setelah Data Pendukung terinput, maka Tingkat Kepadatan
Penduduk Desa akan muncul otomatis seperti gambar berikut:

0. Form Validasi Data & Hitung Indikator Ver.Hsludsk - Excel Sign in [cal

Pagelayout  Formulas Data  Review View Help Q@ Tellmewhat 0 9 Share (]

[
"D g"v Calibri - 20 Wrap Text General - @ Q %ﬂ %( @ E: '%‘Y p
Paste B I ou- E=55 [ Merge&iCenter - | - % » %0 £ | Conditional Formatas Cell | Insert Delete Format _ Sort& Find &
- Formatting = Table~ Styles~ - - - @~ Filter~ Select~
Clipboard 1% Font ] Alignment ] Number ] Styles Cells Editing ~
A6 - fe v
A 8 [ ¢ | b | 3 T | U | v | w | X | ¥ z AN | AB. -
1 |VALIDAS| DATA PENDUKUNG H
2 | Food Security and Vulnerability Atias (FSVA-Desa) 2019
3
. Sumber Data Dasar Proyeksi BPS Dinas validasi KESEPAKATAN KESEPAKATAN
= Tahun
Kode Desa/ Nama Desa/ c. Jumiah
5 :| flama Kecamatan  ode K€ e\uyanan Kelurahan Rumah Tangga
7| 1PULAUBANYAK 1102 1102010003 PULAU BAGUK 397
8| 2 PULAU BANYAK 1102 1102010004 PULAU BALAI 401
9 | 3 PULAUBANYAK 1102 1102010005 TELUK NIBUNG 248
10| 4 PULAU BANYAKBARAT 1102 1102011001 ASANTOLA 04
11| 5 PULAUBANYAK BARAT 1102 1102011002 UJUNG SIALIT 261
12| 6 PULAU BANVAK BARAT 1102 1102011003 HALOBAN 234
13| 7 PULAU BANYAK BARAT 1102 1102011004 SUKA MAKMUR %
14| 8 sINGKIL 1102 1102020003 PULO SAROK 1047 1047
15| 9 siNeKIL 1102 1102020004 PASAR SINGKIL 376 376
16| 10 SINGKIL 1102 1102020005 UJUNG 541 541
17| 11 sINGKIL 1102 1102020006 KOTA SIMBOLING 7 7
18| 12 sINGKIL 1102 1102020007 KILANGAN 380 380
19| 13 sINGKIL 1102 1102020008 TELUK AMBUN 215 215
20| 14 sINGKIL 1102 1102020010 RANTAU GEDANG 147 147
21| 15 SINGKIL 1102 1102020011 TELUK RUMBIA 192 192
22| 16 SINGKIL 1102 1102020012 TAKAL PASIR 153 153
23| 17 siNeKIL 1102 1102020013 SELOK ACEH 157 157
21| 18SINGKIL 1102 1102020014 PEA BUMBUNG 125 125
25| 19 sINGKIL 1102020015 PEMUKA
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Jika input untuk data mentah indikator dan data pendukung sudah
dilakukan, pindahkan kursor ke sheet Hitung Indikator. Data-data
indikator yang sudah dihitung akan ditampilkan pada sheet ini.

0. Form Validasi Data & Hitung Indikator Ver.Hslxdsx - Excel

View  Help Q  Tell me what you want to do

A - £ | No v
A B C D E F G H 1 ] K -
1 [PERHITUNGAN DATA INDIKATOR INDIVIDU Kabupaten/Kota:  ACEH SINGKIL
2 |Food Security and Vuinerability Atias (FSVA-Desa) 2019
3
Arah Persepsi Indikator Positif (+) Positif (+) Negatif (- Negatif (-] Negatif (-} Negatif (-}
4
5 Aspek Ketersediaan Ketersediaan Akses Akses Pemanfaatan Pemanfaatan
Kode Desaf 1 Rasio luas lahan 2. Rasio Jumiah 3. Rasio Jmih Pddk 4. Desa yang tidak 5.Rasio jumlah 6.Rasio Jumlah
Mo. Nama Kecamatan  KodeKee - Nama Desa/ Kelurahan baku sawah terhadap  sarana dsn prasarana tingkst keszjahteraan memiliki akses rumah tangga tanpa  penduduk per tenaga
13 luas wilavah penyedia pangan terendah (Desil 1) memadai ‘akses air bersih terhadap
7 1 PULAU BANYAK 1102 1102010003 PULAU BAGUK A ms B - . T
8 2 PULAU BANYAK 1102 1102010004 PULAU BALAI 0,00 0,11 031 4 048 20
k] 3 PULAU BANYAK 1102 1102010005 TELUK NIBUNG 0,00 0,01 0,48 4 047 856
10 4 PULAU BANYAK BARAT 1102 1102011001 ASANTOLA 0,00 0,07 0,39 1 0,60 3151
11 5 PULAU BANYAK BARAT 1102 1102011002 UJUNG SIALIT 0,00 0,04 055 4 0,03 266
12 6 PULAU BANYAK BARAT 1102 1102011003 HALOBAN 0,00 0,08 0,49 1 0,63 4863
13 7 PULAU BANYAK BARAT 1102 1102011004 SUKA MAKMUR 0,00 0,02 0,44 4 0,43 1309
14 8 SINGKIL 1102 1102020003 PULO SAROK 0,00 013 0,07 1 0,05 19
15 9 SINGKIL 1102 1102020004 PASAR SINGKIL 0,00 0,09 0,09 1 0,00 133
16 10 SINGKIL 1102 1102020005 WUNG 0,00 0,12 018 1 013 563
17 11 SINGKIL 1102 1102020006 KOTA SIMBOLING 0,00 011 0,23 2 021 85
18 12 SINGKIL 1102 1102020007 KILANGAN 0,00 0,02 0,13 1 0,04 224
19 13 SINGKIL 1102 1102020008 TELUK AMBUN 0,00 0,03 029 3 057 39
20 14 SINGKIL 1102 1102020010 RANTAU GEDANG 0,00 0,14 0,56 2 0,84 1679
21 15 SINGKIL 1102 1102020011 TELUK RUMBIA 0,00 0,08 0,55 2 0,87 6534
22 16 SINGKIL 1102 1102020012 TAKAL PASIR 0,00 013 0,34 1 0,72 1647
23 17 SINGKIL 1102 1102020013 SELOK ACEH 0,00 0,08 0,28 1 0,27 967
24 18 SINGKIL 1102 1102020014 PEA BUMBUNG 0,00 0,05 0,36 2 0,16 2757
25 19 SINGKIL 1102 1102020015 PEMUKA 0,00 0,04 0,61 1 1,00 308 8 ~
i & .
i o = 1 + 80%
—_p a0 I
- Rt 5080019

Cek terlebih dahulu data-data indikator tersebut apakah cell sudah
terisi semua apa belum. Jika ada cell yang kosong, silahkan lakukan
penyesuaian data tersebut dengan menggunakan data indikator desa
induk.

Cell kosong atau #N/A pada sheet Hitung Indikator terjadi karena
masih ada data-data mentah yang belum lengkap atau memang tidak
tersedia datanya.

Setelah dilakukan penyesuaian data pada cell kosong atau #N/A,
lakukan Save pada O0.Form Validasi Data & Hitung Indikator
Ver.Hsl, kemudian tutup Form Validasi tersebut sebelum
melanjutkan langkah analisis pada Form berikutnya.
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2.5 Penentuan Cut Off Point Indikator Individu

Setelah mempersiapkan enam data indikatorindividu yang digunakan
dalam analisis FSVA Kabupaten, langkah selanjutnya adalah
menentukan cut off point (titik potong) untuk masing-masing indikator
individu.

Buka 1.Form Penentuan Cut off Point Individu Ver.Hsl untuk
melakukan proses perhitungan cut off point. Titik potong yang
digunakan untuk mengelompokkan data kedalam enam kategor
adalah titik potong 15%, 30%, 50%, 70% dan 85%. Setelah dibuka
form tersebut maka akan terlihat tampilan seperti dibawah:

1. Form Penentuan Cut off Point Individu Ver.Hs1 xsx - Excel

AU nset  Pagelayout  Formulas  Data  Review  View  Help Q' Tellme whatyouwanttodo
- ¥ _ = = |3 p
Calib 12 Ky =E=_ % |[2wWapTen General B - 4 W | €= \x @ p
DE@- = & g p : o 85 = = A d
Paste Bl u- H- B-A- === == EMegetConer - | T % 5 %3 8 | Conditional Formatas Cell | Insert Delete Format _ Sont& Find&
- Formatting = Table~ Style: EE Filter - Select -
Clipboard 1 Font ] IF1 Number IF1 Styles Cells Editing ~
| SECURITY WARNING Automatic update of links has been disabled Enable Content x
A4 e I
A B < ] E F & H 1 J K [a
1 |DATA INDIKATOR INDIVIDU FSVA-Desa 2019
2 |KabfKota:
5
e T . 1Fhsinl\lnhhm|? 3. RasiaImih ngkat 4. iki 5. Rasio ]l ’ . Rasio.
No. T Nama Dess/ Kelurahan il e 5 = = z
Kelurahan o [Desil 1) memadai terhadap tingkat
. - - - - - rumahtsngza - penduduk - stausiratauudara - rumshtangza - kepadatan penduduk +
5
&
7
s
3
10
1
2
=
14
15
i
T
pt 3
15
)
21
2
3
=
25
26
27
=
aal A
» Data FSVA Kab 2019 || 1.Rasio Luaslahan  2.Rasio Sarana Pangan | 3. Rasio Tidak Sejatera | | 4 Akses Jalan | = 5.Rasio Tanpa AirBersh . +) <« v
= +

25 ' e e T A

Jika muncul tampilan “Enable Content” pada form, maka klik “Enable
Content” untuk melanjutkan proses pada tahap berikutnya. Sehingga
tampilan form seperti berikut:
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Ei B 1. Form Penentuan Cut off Paint Individu Ver.Hs1.xisx - Excel

Insert  Pagelayout  Formulas  Data Help @ Tell me what you want to do

[

o, L. m ch -
0 ® | ot -2 A A 2 Wrap Text General - 4 } & & @ = '%‘Y p
pasie B y Conditional F Cell | Insert Delete F g
aste B rou- - erge & Center -~ | B2+ % 3 | %8 9% onditional Formatas Cel nsert Delete Format | - Sort& Fin
- Formatting = Table~ Stylesw | = v = ¥~ Filter~ Select -
Clipboard 1 Font & Alignment [ Number [ Styles Cells Editing A
A4 < £ | No. v
Iy e L < | o E | F | e | H | 1 | J | Kk[=
1 |DATA INDIKATOR INDIVIDU FSVA-Desa 2019
2 |KabfKatas acersinGrL
zl
3. Rasio Jmih Pddk tingkat. 4. Desa yang tidak memiliki
’
No. Ty 5
Kelurahan (Desil
e B el - P
50 PULAU BANYAK PULAU BAGUK 1102010003 ,0000 0,1057 05048 4 0,420 m
N PULAU BANYAK PULAU BALRI 1102010008 0,0000 0,1095. 0,3078 a 0,4810. 0
ap PuLAU BaRvAK Tew nuNG 1202010005 0,000 o008 o2 B oams 6
ol FULAU BanvaK BaRAT asanrowa tzo0n1001 0,000 some o018 R 057 aim
s s PULAU BANYAK BARAT UIUNG SIALIT 1102011002 00000 00021 o582 a
105 PULAU BANYAK BARAT HALGBAN 1102011003 0,0000 0,081, 0,as85 1
ulr PULAU BANYAK 8ARAT Suxa AR 1202011004 0,000 o002 08403 B
1z[s sinaxL FuLo saRoK 110020003 0,000 o1zt om0 R
i) SINGKIL PASARSINGKIL 1102020004 00000 o.080 o003 1
14 sinGrL uNG 1102020005 0,0000 0,164, 01751 1
1511 s xoTASIMBOLNG 1202020008 0,000 o1 oz 2
16|12 SINGKIL KILAKGAN 1102020007 0,000 0,018 01268 1
17|15 SinGKIL TELUKAMBUN 1102020009 0,0000 o,0326. 02882 3
18 |1 SinGrL RANTAU GEDANG 1102020010 0,0000 0,1357. 0,5596 2
115 sincL Tewcrumsa 1202020011 0,000 oo o512 2
21 SINGKIL TAKALFASIR 1102020012 0,000 0,305 05330 1
Al SinGKIL SELOKACEH 1102020013 0,0000 0,0785. 02818 1
2|15 SinGrL PEA BUMBUNG 1102020018 0,0000 0,0480. 0,3636 2
F sincL remua 1202020015 0,000 oo 05108 '
2|20 SINGKIL SUKA DAMAI 1102020018 0,000 0,031 CEEr) 1
F SinGKIL UIUNG BAWANG. 1102020020 0,0000 o,0159. 03530 2
26|22 SinGrL SITIAMBIA 1102020021 0,0000 0,0485. 0,179 2
7|n sincL Suxa marwUR 1202000022 0,000 [er 0,132 2
I SINGKILUTARA. GOSONG TELAGA UTARA 1102021001 0,000 o0z 01737 1
FElE SINGKILUTARS GOSONG TELAGA SELATAN 1102021002 0,0000 o,0330 0,3a88 1
025 SINGKILUTARR GOSONG TELAGA TIMUR 1102021003 0,0000 0,0526. 0,3308 1
E T eina

i)

» Menentukan cut off point Indikator (Arah Persepsi Positif)

Geser kursor ke sheet Rasio Luas Lahan untuk memulai proses
penghitungan cut off point pada indikator rasio luas lahan. Tampilan

awal seperti gambar dibawah ini:

g -

Insert

Page Layout

Formulas

Data Review

View

1. Form Penentuan Cut off Point Individu Ver.Hsl xlsx - Excel

Help

Q  Tell me what you want to do

- X = = | 3. A
Calibs -l 20 Wrap Text General - - g Ex p
Dg. [ 2 Wrap enera L2 » [ B E a4
Paste Bl ru- - erge & Center - | 7~ 05 s % 2§ | Conditional Formatas Cell Insert Delete Format _ Sorté Find &
- Formatting = Table~ Styles~ - - - 7 Filter~ Select~
Clipboard 1= Font & Alignment Number 5 Styles Cells Editing ~
AL - Je | 1. Rasio Luas Lahan 2

C D
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Kemudian blok kolom E (Rasio Luas Lahan) dan kolom F (Range),
lalu klik Data, lalu pilih Sort sehingga muncul tampilan berikut:

g - . Form Penentuan Cut off Paint Individu Ver.Hsl xisx - Excel

Home  Insert  Pagelayout  Formulas Q' Tell me what you want tc

B F [ show Queries F [£] Connections Al El% Flash Fill f-= Consolidate i @ EBGroup + =
P z i B -~
=] [ From Table &[] Properties V; Reappl: BB Remove Duplicates =3 Relationships o EH Ungroup -
GetExternal | New Refresh 7| Sort | Filter Tetto What ¥ Forecast
Data~ Query - L5 Recent Sources A= o EditLinks i Vo Advanced | Columns 55 Data Validation - (i Manage Data Model | analysis~ Sheet | i Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] “~
E2 - F | =IF['Data FSVA Kab 2019'IE5="";"";'Data FSVA Kab 2019'E5)
A 8 c D E F 6 H 1 Jo |k | L | M | N o P Q R s E
Range Ranking
0,0000/  0,0000 Cut Off Point Indikator Rasio Luas Lahan Baku Sawah terhadap Luas Wilayah Desa
Min 0,0000 0,0000  0,0000
Max 0,147 0,0000 0,000 60
Qz (50%) 0,0000 0,0000  0,0000
0,0000  0,0000
0,0000  0,0000
15% 18 0,0000 0,000 Sart -
30% 35 0,0000  0,0000
70% a2 0,0000  0,0000 [ *2| Add Level ][ 7% Delete Level ][ E2) Copy Level ”BB[ Options... ] My data has headers
85% 99 0,0000  0,0000 Column Sort On Order

0,0000 0,000
0,0000  0,0000
0,0000 0,000
0,0000  0,0000
0,0000 0,000
0,0000  0,0000
0,0000 0,000
0,0000  0,0000

Sortby |1, Rasio Luas Lahan [] [Cell Values [=] [atoz [=]

BB EGEE B e nwm|-

20| 0,0000  0,0000,
2| 0,0000  0,0000
22 0,0000  0,0000,

DTSR 201 | st s o | e S PAG T —

Average: 0,019197685 Count: 1744 Sum: 4,453862947 H M -+ 100%

Kemudian ganti Sort by menjadi Range, dan pastikan Order adalah
A to Z, lalu klik OK seperti tampilan dibawah:

& = Fe ntuan Cut off Paint Individu VerHs xlsx - Ex

Home  Insert  Pagelayout  Formulas ' Tell me what you want to do

B F [ show Queries F [£] Connections El% Flash Fill f-= Consolidate i @ EBGroup + =
& i ; -~
=] [ From Table & [7] Properties Reappl BB Remove Duplicates =3 Relationships . &8 Ungroup - —

GetExternal | New Refresh 7| Sot | Filer Textto What-Ff Forecast

Data~ Query - L5 Recent Sources A= o EditLinks i Vo Advanced | Columns 55 Data Validation - (i Manage Data Model | analysis~ Sheet | i Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] “~
E2 & J | =IF['Data FSVA Kab 2019'IES="";"";'Data FSVA Kab 2013'E5)
A B c D E F 6 | H I J | kK | L | M | N s} P Q R s E

Range  Ranking

0,0000/  0,0000 Cut Off Point Indikator Rasio Luas Lahan Baku Sawah terhadap Luas Wilayah Desa
Min 0,0000 0,0000  0,0000
Max 0,1447 0,0000  0,0000 60
Q2 (50%) 0,0000 0,0000  0,0000
0,0000  0,0000
0,0000  0,0000
15% 18 0,0000  0,0000 Sort -
30% 35 0,0000  0,0000
70% 82 0,0000  0,0000 *2| Add Level H X Delete Level H E2) Copy Level Hmm[ Qptions... \ Iy data has headers
85% 99 0,0000  0,0000 Column Sort On Order

0,0000 0,000
0,0000  0,0000
0,0000 0,000
0,0000  0,0000
0,0000 0,000
0,0000  0,0000
0,0000 0,000
0,0000  0,0000

Sortby | fzhge [=] [cenvalues [=] [atoz [=]]

BB EGEEBEEewNeanwm|-

20| 0,0000 0,000
21| 0,0000  0,0000
22| 0,0000
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Lalu akan muncul tampilan seperti dibawah ini:

H - ﬁ = 1. Form Penentuan Cut off Point Individu Ver.Hs1 xsx - Excel Sign in |

File ~ Home Insert  Pagelayout i Help Q' Tell me what youwant to

B le [l Show Queries F"‘ [ co Y h 4 Ell?ﬁ Flash Fill f-a Consolidate : Group ~
EaE | po [ From Table Refr:h o) ot | e W Reapply . BB Remove Duplicates = Relationships e &8 Ungroup -
Data~ | Query- LGoRecentSources | . [ EditLinks B Vo Advanced | Colymns 5 Data Validation - (i Manage Data Model | pnalycis~ Sheet | Eij Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] ~
E1 52 J | 1. Rasio Luas Lahan v

C

| Data FsvA Kab 2019

Average: 0,019197685  Count: 1744

Setelah terihat urut dari nilai 0,000 sampai 1,000 pada kolom
Range, maka isi kolom Ranking dari atas dengan nilai 1,2,3,.. dan
seterusnya sampai data terakhir. Sehingga tampilan akan berubah
seperti gambar dibawah:

H ©- g - 1. Form Penentuan Cut off Paint Individu Ver.Hsl xisx - Excel Sign in
File Home Insert  Pagelayout  Formulas Review  View Help @ Tell me what you want to do
B FEI [ Show Queries rﬂ [2] Connections Y B El"é EE7 Flash Fill B+ Consolidate E’? @ EEE Group ~ i
1 Fram Table &[] Properties Ve Reappl BB Remove Duplicates ™5 Relationships ZE Ungroup ~
GetBxternal | New Refresh z| Sort | Filter Tedto _ i What-If Forecast
Data - Query - L Recent Sources Al- ol Edit Links L2 Vo hdvanced | Columns 55 DataValidation - [ Manage Data Model | anaiysis~ Sheet | ELd Subtotal
Get & Transform Connedions. Sort & Filter Data Tools Forecast Outline ) ~
AL - Je | 1. Rasio Luas Lahan 2
€ D E I J| K | L | M | N o P Q R s E
0,0000
3 0,0000  0,000f
4| 0,0000  0,000f
5 0,0000  0,000f
& 0,0000  0,000f
7 0,0000  0,000f
] 0,0000 0,004
9 | 0,0000  0,000f
1 0,0000 0,004
11 | 0,0000  0,000f
12 0,0000  0,000f
0,0000  0,000f
0,0000  0,000f
0,0000  0,000f
0,0000  0,000f 15
0,0000  0,000f 16
0,0000  0,000f 17
0,0000  0,000f 18
20 0,0000  0,000f 13
21 0,0000  0,000f 20
22

» || DataFSVAKab2018 | 1 Rasio Luas Lahan
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Pada gambar diatas terlihat besaran nilai pada masing-masing titik
potong. Sehingga nilai titik potong inilah yang akan dijadikan sebagai
batasan selang pada masing-masing prioritas.

Terlihat juga ada penyamaan persepsi titik potong pada indikator ini
dari arah positif menjadi negatif. Penyamaan persepsi titik potong
dilakukan untuk menyamakan arah persepsi dengan keempat
indikator lain yang bersifat negatif. Penyamaan persepsi titik potong
ini digunakan untuk kepentingan penentuan cut off point (titik potong)
indeks komposit.

Setelah semua cell terlihat terisi, maka lakukan langkah yang sama
untuk sheet berikutnya Rasio Sarana Pangan. Indikator ini
mempunyai arah persepsi yang sama (arah positif) dengan indikator
Rasio Luas Lahan. Sehingga titik potong pada indikatorini juga periu
disamakan arah persepsinya dan tampilan akan muncul seperti
gambar dibawah:

1. Form Penentuan Cut off Point Individu Ver.Hsl dsx - Excel

Help  Q Tellme what you want to do

= [Ishow Queries [=] Connections | H Y V5 Flash Fill B2 Consolidate ’:\ @ 8 Group -
. rtl [ From Table FQ 2 Bl B-A Remove Duplicates ’? EH Ungroup ~
Get External New - Refresh 7| Sort Filter Tetto What-If Forecast |
Data~ Query - L5 Recent Sources All- |2 Edit Links Vo Advanced | Columns S5 Data Validation - Manage Data Model | anolysis- Sheet | Eij Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] “~
El - 3 2. Rasio Sarana & Prasarana v
A B c D E F T 1 J K L M N o P Q R s -
2. Rasio 2. Rasio
Sarana & Sarana& | Range | Ranking
1 Prasarana Prasarar - - -
2 0,0000 0,000 1 | | Cut Off Point Indikator Rasio Sarana dan ia Pangan Jumlah Rumah Tangga
3 Min 0,0000 0,0000 0,000 2
4| Max 0,2757 0,0000 0,000 3 40 E 60
5 | Qz(50%) 0,0488 0,0000 0,000 a
6 0,0000 0,000 5 [ 00123 10,032926 0,0488 0,077512
7 [CposisiRanking NilaiRasio | | 00000 o,000 s
] 15% 18 0,0123 0,0000 0,000 7 | Prioritas 1 <=0,0123
9 30% 35 0,0329 0,0000 0,000 8[| Prioritas 2 > 0,0123 0,0329
10| 70% 82 0,0775 0,0000 0,000 s Prioritas 3 > 0,0329 0,0488
11|  85% 99 0,1131 0,0000 0,000 10| | Prioritas 4 > 0,0488 0,0775
12 0,0000 0,000 11/ | Prioritas 5 > 0,0775 0,1121
13 0,0064  0,0233 12| | Prioritas 6 > 10,1131
14 0,0081  0,0293 13
15 0,0085  0,0308 14 | Penyamaan Persepsi
16 0,0095  0,0345 15
17 0,0106  0,0385) 16| | |Prioritas 1 0,2634
18 00123  0,0845 17| | Prioritas 2 0,2428
19 0,0168  0,0609 18| | |Prioritas 3 0,2269
20 0,0184  0,0669 19| | Prioritas 4 0,1982
21 0,0192  0,0695) 20/ | Prioritas 5 0,1626
22 0,0202 0,073 21/ | |Prioritas 6 0,0000
+ » .. |PiRasiclluasiahan’l 2. Rasio Sarana Pangan _ | 4. Akses jalan | 5. Rasio Tanpa Air Bersih 6. Rasio Pddk per Tenh ... (+) < v

Ready H m - 1 + 100%
| | ’ 13:54
22/04/2019

» Menentukan cut off point Indikator (Arah Persepsi Negatif)

Ada empat indikator yang mempunyai arah persepsi negatif yaitu
Rasio Tidak Sejahtera, Akses Jalan, Rasio Tanpa Air Bersih, dan
Rasio Penduduk per Tenkes.
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Geser kursor ke sheet Rasio Tidak Sejahtera untuk memulai proses
penghitungan cut off point pada indikator Rasio Tidak Sejahtera.
Tampilan awal seperti gambar dibawah ini:

E[ = 1. Form Penentuan Cut off Point Individu Ver.Hsl xlsx - Excel

Insert  Pagelayout  Formulas  Data  Review  View Help Q' Tellme whatyouwantto do

= =
- A A - ab - B i 2 - A p
D E@ ) Calibri 11 oy E 28 Wrap Text General i 2 } & Ex @ = A d
Paste Bl u-|E- DA = erge & Center - | 0+ 95 3 %3 9§ Conditional Formatas Cell Insert Delete Format Sort & Find &
- — Formatting = Table~ Styles~ - B - 7 Filter~ Select -
Clipboard 1= Font & Alignment = Number = Styles Cells Editing ~
Al - 5 3. Rasio Pddk Tidak Sejahtera v
A B c q E E G H 1 J K L, M | N o P Q R s T | E
Cut Off Point indi Rasio k Tidak Sej ' Jurniah

40 + 60 7

0,3077

| Data FSVAKab 2019 3. Rasio Tidak Sejahtera

[aieesEnY] | 5. v Tenpa Airgersh | .. © ]

i O -+ 100%
—

Kemudian blok kolom E (Rasio Pddk Tidak Sejahtera) dan kolom F
(Range), lalu klik Data, lalu pilih Sort sehingga muncul tampilan
berikut:

Ho R - s

File Home Inset  Pagelayout  Formulas Review  View Help Q@ Tell me what you want to do

[ Show Queries [=] Connections N %C £ Flash Fill B+ Consolidate as EE Group ~ =
B & T 8l Bl ir S
[jrmm Table [E] Properties W Reappl BB Remove Duplicates ™7 Relztionships - B8 Ungroup - =
Get Biternal | New Refresh z| Sort | Filter Textto What-If Forecast
Data - Query - L& Recent Sources Al- b Edit Links LS Vo hdvanced | Columns 5 DataValidation - [ Manage Data Model | pnaiysis~ Sheet | L Subtotal
Get & Transform Connedions. Sort & Filter Data Tools Forecast Outline n ~
£ - F | =IF['Data FSVA Kab 2019'1G5="";"";'Data FSVA Kab 2019'\G5)
A 8 c D E F |G H 1 J K Ll M | N o P Q R s T | E

0,3448|  0,3958] Cut Off Point k Tidak sej t Jjumiah
Min 0,0229 0,3076 0,350,
Max 0,8362 04822 0,5647,
Q2 (50%) 0,3077 03319 0,4537,
| 05462  0,6434|
04885 0,5725,
15% 18 0,4403 0,513
30% 3 00710, _0,0592 Column Sort On Order
TS 82 0,0913 0,084 | [sortby | =] |cenvalues [=] |Atoz [=]
85% 93 01751 01872,

0,2291 0,253
0,1268  0,1277
0,2862  0,3237,
0,5596  0,6599|
0,5512  0,6496|
0,3390 0,388
0,2818  0,3183]
0,3636 0,418

S A e e A N

20| 0,6108  0,7228|
21| 04382 0,5107
22| 0,3530  0,4058|

b

+ osrsvakebais | LR s iahn | 2 Rt Sorea g | 3. i T s |RGESIRRY | SR Towakenesh . 0

Average: 0,336554106 Count: 1744  Sum: 78,08751254 H @ [ -—F—+ 100%
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Kemudian ganti Sort by menjadi Range, dan pastikan Order adalah
A to Z, lalu klik OK seperti tampilan dibawah:

B ©- @ = . For ntuan Cut off Paint Individu Ver.Hsl xisx - Excel

File Home Insert  Pagelayout  Formulas Q' Tell me what you want tc

[ show Queries [=] Connections Vv Flash Fill fr= Consolidate @ EEGroup + =
= FE' [ From Table Fg p es V= Reappl B= BB Remove Duplicates =5 Relationships E? 28 un, .zu .=
GetExternal | New Refi o v S What f Forecast | = o b

7| Sort | Filter Text t

roperties
resh o
Data~ Query - L5 Recent Sources A= o EditLinks Vo Advanced | Columns 55 Data Validation - (i Manage Data Model | analysis~ Sheet | i Subtotal

Get & Transform Connedtions Sort & Fifter Data Toals Forecast Outline ® -~
£ M f | =IF('Data FSVA Kab 2019'1G5="";"";'Data FSVA Kab 2019'lG5)
A B c D E F | & H 1 ) K L M | N o P Q R s T | E
Range Ranking
0,3448|  0,3958] k Tidai Sej } Jumiah
Min 0,0229 0,3076 0,350,
Max 0,8362 04822 0,5647,
Q2 (50%) 0,3077 03319 0,4537
05462 0,6434
0,4885  0,5725,
15% 18 0,4403  0,5133] ‘ni add Level || X Delete Level |[ Bz copy Level [ « ||~ |[ options... | My data has headers
= —
;Z Z’gg Z’Ei Column Sort On | Order I
B2 i i | Il sortby | Range: I=] |cenvalues AtoZ
85% 99 01751  0,1872, | e =] | =1 5]

0,2291 0,253
0,1268  0,1277
0,2862 03237,
0,5596  0,6599|
0,5512 0,649
0,3390  0,3887
0,2818  0,3183]
0,3636  0,4189|

BB EGEE B N eanwm|-

2] 06108 0,728
21 04382  0,5107]
22 0,3530  0,4058|

A T

Average: 0,336584106  Count:1744  Sum: 78,08751254 | HH M -+ 100%
_—

H ©- &g - 1. Form Penentuan Cut off Paint Individu Ver.Hsl xisk - Excel Sign in ial

File ~ Home Insert Pagelayout  Formulas Review View Help Q' Tellmewhat youwanttc

[=lShow Queries =] Connections Y % L) Flash Fill B2 Consolidate BHeowp -+
= FD [ From Table Fc e i Y Reapphy Ei5 BB Remove Duplicates = Relationships E8Ungroup - =
Get External | New Refresh z| Sort | Filter Tette What-If Forecast |
Data~ | Query- LGoRecentSources | . [ EditLinks B Vo Advanced | Colymns 5 Data Validation - (i Manage Data Model | pnalycis~ Sheet | Eij Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] ~
EL 2 J | 3.Rasio Pddk Tidak Sejahtera v
A 8 c G H 1 J K Ll M | N o P Q R s T | E
0,0229  0,0000 Cut Off Point indil Rasio k Tidak Sej ' Jurniah
Min 0,0229 0,0242  0,0017,
Max 0,8362 0,0300 0,007 60
Q2 (50%) 0,3077 0,0458 0,028
0,0474  0,0302]
0,0513  0,0357
15% 18 0,0525  0,0364
30% 35 0,0626 0,042
70% 82 0,0651  0,0519|
85% 99 0,0661  0,0531]

0,0661  0,0532
0,0710  0,0592|
0,0763  0,0636|
0,0773  0,0676|
0,0870 0,078
0,0820  0,0801]
0,086 0,0808|
0,0913  0,0841]

BESELREUEEE 9 ® a0 s wm-

20| 0,0923  0,0854)
2| 0,0952  0,0883
22| 0,0995 0,0942

© o R L e —

Average: 0,336584106 Count:1744  Sum: 78,08751254 H

Setelah terihat urut dari nilai 0,000 sampai 1,000 pada kolom
Range, maka isi kolom Ranking dari atas dengan nilai 1,2,3,.. dan
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seterusnya sampai data terakhir. Sehingga tampilan akan berubah
seperti gambar dibawah:

5 Share
fr= Consolidate EEGroup + =
i & o

F [ Show Queries T El% 57 Flash Fill
P H -
=] [ From Table &~ F B-A Remove Duplicates = E8 Ungroup ~
GetExternal | New Refresh 7| Sort | Filter Tetto What ¥ Forecast
Data~ Query - L5 Recent Sources A= o EditLinks i Vo Advanced | Columns 55 Data Validation - (i Manage Data Model | analysis~ Sheet | i Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] “~
El & I 3. Rasio Pddk Tidak Sejahtera v

@ N W N

g

minnleeleee e e
(=21 =[5 12 1[G (5[5 (589 12 S|

W ol e
z

Pada gambar diatas terlihat besaran nilai pada masing-masing titik
potong. Sehingga nilai titik potong inilah yang akan dijadikan sebagai
Batasan selang pada masing-masing Prioritas. Titik potong ini juga
digunakan untuk kepentingan penentuan cut off point (titik potong)
indeks komposit.

Setelah semua cell terlihat terisi, kecuali Akses Jalan maka lakukan
langkah yang sama untuk sheet berikutnya Rasio Tanpa Air Bersih
dan Rasio Pddk per Tenkes. Sehingga tampilan sheet akan muncul
seperti gambar berikut:

Tampilan sheet Akses Jalan;

Prioritas 1 Tidak dapat dilaiui sepanjang tahun
Bisa dilalui Sepanfang tahun kK i sepanjang i hufan
Bisa dilalui Sepanfang tahun kecuali saat tertentu (ketika turun hujan, pasang, dif)

Bisa dilalui Sepanjang tahun

Prioritas 2
Prioritas 3
Prioritas 4

INw

cCatatan: Berlaku untuk seluruh kabupaten dan kota

-+ || 1.Rasio Luas Lahan | 2. Rasic Sarana Pangan || 3. Rasic Tidak Sejahtera || 4. Akses Jalan | 5. Rasio Tanpa Air Bersin |
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Tampilan sheet Rasio Tanpa Air Bersih;

H ©- B - 1. Form Penentuan Cut off Paint Individu Ver.Hs1 xisx - Excel =

File ~ Home Insert Pagelayout  Formulas Review View Help Q' Tellmewhatyouwantto

E F [l Show Queries ’T [=] Connections 8l Y b4 E?- [E” Flash Fill f-a Consolidate Group ~
- ~ z =] -
= [ From Table =~ rop W Reapply BB Remove Duplicates = Relationships &8 Ungroup -
Get External | New Refresh z| Sort | Filter Tette What-If Forecast
Data~ | Query- LGoRecentSources | . [ EditLinks B Vo Advanced | Colymns 5 Data Validation - (i Manage Data Model | pnalycis~ Sheet | Eij Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline ] ~
AL M J | 5.Rasio Tanpa Air Bersih v

C D E

B = 1. Form Penentuan Cut off Paint Individu Ver.Hs1 xisx - Excel =

2 Share (-]

Insert  Pagelayout  Formulas View Help @ Tellme whatyouwant

== e B
0 % Calibri -l - A A - 2 Wrap Text General - EE' %} E& &= B E b3 'Z‘\‘Y p
Fay - =] 9-
Paste Bl:r u-|i5- D-A- Merge & Center - | (7« 9 5 %§ §§ | Conditional Formatas Cell | Insert Delete Format _ Sorté Find &
- Formatting = Table~ Styles ™ - - - 7 Filter - Select -
Clipboard & Font = Alignment 5 Number 5 Styles Cells Editing ~
Al - fe | 6.Rasio Pddk per Tenkes v

C D E

2,9719 Cut Off Point
4,6134
6,6764
7,3764
8,0830
8,3383
9,6319
93,7064
12,2309
17,3644
18,9537
20,2236
23,1591
24,8290
24,8705
25,0563
27,3506
31,7552
39,1272
42,1267

14:35

p il M -

Setelah selesai, lakukan Save pada 1.Form Penentuan Cut off
Point Individu Ver.Hsl, kemudian tutup Form tersebut untuk
melakukan tahapan analisis selanjutnya.

11-25 Analisis KompositFSVA
Kabupaten 2019



2.6 Penyamaan Persepsi Data Indikator dan Entry Bobot

Setelah penentuan cut off point indikator individu dilakukan, langkah
selanjutnya adalah melakukan persamaan persepsi untuk data
indikator pada Rasio Luas Lahan dan Rasio Sarana Pangan.

Buka 2.Form Analisis FSVA Kab 2019 Ver.Hsl1l untuk melakukan
proses penyamaan persepsi untuk kedua indikator tersebut.

B = 2. Form Analisis FSVA Kab 2019 VerHs1 xisx - Excel
Insert  Pagelayout  Formulas  Data  Review View Help @ Tellmewhatyouwantto do
- ¥ = - =y A
Calibs BT =E=_ ® 2 Wrap Text General - o 2] 4 | == BX p
DE@v alibri A A = ¥ 2 WrapTet | General = 2 s &5 = z- ZY
Paste B I u- e D-A- === =55 ElMegetiCenter - - % s % 5 | Conditional Formatas Cell | Insert Delete Format _ Sort& Find &
- Formatting = Table~ Styles~ . - . Filter = Select~
Clipboard 1 Font @ @ Number @ Styles Cells Editing “
I SECURITY WARNING Automatic update of links has been disabled Enable Content x
A6 52 £ || No. v
a s c o e 13 c ® ' 3 L M LT
: |Data Indikator 2019
2| Faod sacuriy and vuersbiley g (Fs-0esa)
s Aseex KETERSEDIAAN PANGAN AKSES PANGAN PEMANFAATAN PANGAN
~pusdatin, ~Podes 2018 -oTesEm fsk.1/2018) _DTEEM(sKTi/088)  -Podes2018
‘sumber - Podes’
- 03 Dsossar Kementan 2018 ~Proyeksi AT 2018 ~Proyeksi Pddk 2015 208 -ProyeksiRT2018 - Proyeksi Pddk 2018
6. Rasio Jumial h
™A | pendusuk pertenaga
3| yesehstan terhadap
tingkat kepadatan
s penduduk
| me | ramaecamann cosexee
7
s
°
0
iy
f
=
m
s
1 et
o P
s
1
»
u
=
=
i
2= -

1. Data 2019 & Entry Bobot | 2. Cut Off Individu & Kemposit 3.Indeks Komposit | 4. Perhitungan Individu | (%) « v
= +

1419
22/04/2019

Jika muncul tampilan seperti diatas, lakukan klik pada “Enable
Content” untuk memulai proses selanjutnya. Terlihat ada tambahan
kolom berwana kuning untuk Rasio Lahan dan Rasio Sarana. Kolom
tersebut digunakan untuk menyimpan data hasil persamaan arah
persepsi.

Setelah di klik "Enable Content” maka akan muncul tampilan seprti
gambar dibawah ini:
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Ei = 2. Form Analisis FSVA Kab 2019 Ver.Hsl xlsx - Excel

Insert  Pagelayout  Formulas  Data  Review  View Help Q' Tell me what you wantto dc

o X T T I
0 Calibri M 2 Wrap Text General - " 2] } & & @
Paste o |[Blr U~ - Merge & Center - | < 9 » % §)  Conditionel Formates Cell | Insert Delete Formal | Sort Find &
- Formatting = Table~ Styles~ - B - #* Filter - Select -
Clipboard 1= Font & Alignment & Number & Styles Cells Editing ~
A6 < £ | No v
a s | ¢ | o | 3 3 | . | " | | . | x | L | ™ |n] H
+ |Data Indikator 2019
2| Food Securityand Vulnerabilty Atcs (FSVA-Desa)
3 KETERSEDIAAN PANGAN axses panGant ~PEMANFAATAN PANGAN
~pusdatin, ~podes 2018 ~oTePEM(sK.71/2018] sots UTPPMIsKT/E) -podeszois
. mentan 2018 ~proyeei RT 2018 ~proyelce pddk 2018 odes -proyeksiRT2018 - proyeksi pddk 2018
§ Penyamsanperseps  3.RsroimhEodt | 4. Dessyangtdsk 5 Rasio umish
1 fasoss ahampap | TEMWATMENPErSERS | 2 Rasioumishsarans 3 . "  vane 5 rasojumishrumsh | " 50
sio s lahanbake | "ot " pentudk pertenas
£ Rasio Luss isnan baky dan prassrans penyeds tanges tanga skeesar
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Untuk mengisi Besaran Bobot Indikator, pada sheet Data 2019 &
Bobot Entry geser kursor kearah kanan sehingga muncul tampilan
berikut:
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4, Perhitungan Individu [«] |

1. Data 2019 & Entry Bobot 2. cut Off Individu & Komposit

®
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Isi kolom Bobot yang berwarna hijau dengan melakukan copy-paste
nilai Bobot yang berada di keterangan bawah. Sehingga tampilan
berubah sebagai berikut:
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2.7 Penentuan Cut Off Point Indeks Komposit

Setelahitu geser kursor ke sheet Cut Off Individu & Komposit untuk
mengecek dan melakukan penghitungan cut off point Indeks
Komposit. Sehingga tampilan berubah seperti berikut:

2. Form Analisis FSVA Kab 2018 Ver.Hsl xlsx - Excel

Formulas Data Review View Help Q  Tell me what you want to do

o = praey .
™ g" Calibri General - 7] } == ;Ej"x E = ‘%Y p
Paste B I u- v | B % 2 | | Condbonal Fomata Cal Insert Delete Format | | Sorta Find &
ormatting = Table - Styles - - B - Filter - Select -

o Number = Styles Cells Editing ~

Clipboard 1

CRCTAT I 1 Rasiolahan 2. Rasio Sarana
0,399

Arah Positif (+}
0,0123
0,0329
0.0488
0,0775
1131
3:

o,
0.1151

5 SKOR KOMPOSIT (Z_Scale)
PRIORITAS vz 2. ¥ K ol

Prioritas 1

|| 1.Data 2019 & Entry Bobot |_2. Cut Off Individu & Komposit | 5.Indeks Komposit || 4. Perhitungan Individu | &) L ]
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Geser kursor kebawah, maka akan terlihat tampilan berikut:

2. Form Analisis FSVA Kab 2019 Ver.Hs1 xsx - Excel
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22| PRIORITAS berwana pink silahkan cek
20 W Nilai Max Z Scaif 100,00 100,00 100,00 100,00 100,00 100,00 oK oK
30 Prio 1 100,00 9554 5347 75,00 7274 2595 dengan aturan:
31 i 2 100,00 88,06 49,25 50,00 57,10 11,78
20 100,00 8231 36,80 4375 3502 461
33 100,00 7188 19,84 31,25 16,07 130 1 Jlka baris ke,z (Warna
34 100,00 58,97 10,60 25,00 4385 042 . A
15 0,00 0,00 0,00 0,00 0,00 pink) masih bernilai sama
36 . e
dengan baris ke-1 atau nilai
BAGIAN Il 1. Rasio Lahan_7 2. Rasio Sarana_Z baris ke-2 lebih besar dari [ 1. Rasio Lahan_7
PRIORITAS 100, maka perlu ada proses PROSES PERGANTIAN

Nilai Max Z
Prioritas 1 = o - 2 Z g
Prioritas 2 0,2362 0,5945 0,4964 23240 0,6395 -0,0430
Prioritas 3 0,2362 0,2770 -0,0348 1,9836 -0,1026 -0,4210
Prioritas 4 0,2362 -0,2985 -0,7585 1,3029 -0,7983 -0,5958
Prioritas 5 0,2362 -1,0114 -1,1528 0,9625 -1,1881 -0,6421
Prioritas & -7,0937 -4,2680

penyesuaian nilai di baris
yang berwana hijau.

2. Penyesuaian nilai di

baris hijau berdasarkan
lebar selang yang sering
muncul

1. Rasio Lahan

2. Rasio Sarana

0,0000 0,0000
0,1247 0,3757

Diatas adalah proses perhitungan cut off point Indikator Individu dan
Indeks Komposit dengan standarisasi dua tahap yaitu Z-Score dan
Scala (0-100). Perhatikan keterangan yang berada dikotak, dan coba
lakukan cek untuk dua baris yang berwarna pink dan satu baris yang
berwarna hijau.

Jika baris ke-2 (warna pink) masih bernilai sama dengan nilai pada
baris ke-1 (warna pink) atau nilai baris ke-2 lebih besardari nilai 100,
maka perlu ada proses penyesuaian nilai pada baris yang berwarna
Hijau.

Penyesuaian nilai di Baris Hijau berdasarkan lebar selang yang sering
muncul. Untuk mengecek apakah ada nilai di baris hijau yang perlu
diganti atautidak, silahkan kursor ke kanan sehingga muncul tampilan
berikut:
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Perhatikan gambar diatas, jika baris warna pink tertulis "OK” maka
silahkan lanjutkan proses analisis ke sheet berikutnya. Tetapi jika
dibaris warna pink muncul tulisan "Nilai Hijau Perlu Diganti” maka
perlu penyesuaian nilai pada baris warna hijau berdasarkan lebar
selang yang sering keluar yang akan muncul dibawahnya.

2.8 Penghitungan Indeks Komposit Pada Masing Wilayah

Karena pada baris warna pink tertulis "OK"” semua, maka geser kursor
ke sheet Indeks Komposit. Sehingga muncul tampilan berikut:
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Sheet tersebut berfungsi untuk menghitung Indeks Komposit pada
masing-masing wilayah (desa) dengan mengalikan antara bobot
indikator dengan data indikator yang sudah distandarisasi dua tahap.
Setelah itu hasil perkalian masing-masing indikator dijumlahkan
sehingga menghasilkan indeks komposit.

Setelah indeks komposit masing-masing wilayah didapatkan, maka
langkah selanjutnya adalah mengelompokkan indeks komposit
kedalam Enam Prioritas Komposit berdasarkan cut off point Indeks
Komposit yang dihasilkan pada sheet sebelumnya.

Prioritas 1 adalah desa yang cenderung memiliki tingkat kerentanan
yang lebih tinggi daripada desa dengan prioritas diatasnya. Begitu
sebaliknya, Prioritas 6 adalah desa yang cenderung lebih tahan pangan

Selain itu pada sheet ini juga bisa menghasilkan peringkat, semakin
tinggi Indeks Komposit suatu wilayah maka peringkatnya semakin
baik. Sehingga dari indeks ini akan dihasilkan urutan kondisi wilayah
dari paling tahan sampai paling rentan.

Jika kursor digeser ke kanan maka akan terlihat cut off point Indeks
Komposit yang digunakan sebagai dasar pengelompokan wilayah
seperti pada gambar dibawah ini:
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2.9 Analisis Indikator Individu

Untuk melakukan analisis terhadap masing-masing Indikator maka
geser kursor ke sheet Perhitungan Individu untuk melihat hasil
pengelompokan wilayah (desa) berdasarkan masing-masing indikator.
Sehingga muncul tampilan gambar seperti dibawah ini:

2. Form Analisis FSVA Kab 2019 Ver.Hsl xisx - Excel
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Pengelompokan Prioritas untuk indikatorindividu dibagi menjadi enam
Prioritas kecuali indikator akses jalan yang dikelompokkan kedalam
empat prioritas.

Di sheet ini juga terlihat Indeks Komposit, Prioritas Komposit, dan
Peringkat masing-masing wilayah. Sehingga hasil di sheet ini sudah
merangkum semua hasil analisis FSVA Kabupaten. Data-data di sheet
ini bisa menjadi dasar untuk melakukan proses selanjutnya yaitu
proses pemetaan.

11-32 Analisis KompositFSVA
Kabupaten2019



MODUL I

PEMETAAN DENGAN SOFTWARE QUANTUM GIS




L MENGENAL PROGRAM QUANTUM (QGIS)

A. Membuka Peta di QGIS

Buka program Quantum GIS (QGIS) dengan cara mengklik tombol Start
dan pilihlah Program>QGIS 2.18> QGIS Desktop 2.18.15 sehingga akan muncul
tampilan seperti dibawah ini:
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Project Edit Tamplan Layer Pengatwan Plugins Vektor Raster Basisdata Web Processiny g Bantuan
= = ® @ D ~ e @ Nl e . p— .
DEBRELR EISLLAPRPPALBNR 2 -H-8-REEYm-C T
B *= .'dﬂ i =<g B nmo@m“m\?mﬁm{jmm csw .H>
Brawser Pangl x

QRTITO

Va

LA
f Favorit
[+

b~ > i 00 Dedi
01_Pelatinan_FSVA

4
@ @ > )i Data
% b Layout
> )i Logo
w"\?& - > U Peta

(3] # Lathan.qgs
E¥ Modul QoIS _tan13.pdf
26 (5 Modul QGIS_Jan18.pdf
Ve v ) 142a7stbsfee0s03crif7si0

- 5ae290bcfdS61faf3beasas7200
c7ea3b80e96e 2141585595b2715553a5
casds2822h 172bd2baazh0 -

Layers Panel 8 %

« @l TE~-HAD

Default tampilan bahasaQGIS adalah Bahasa Inggris, akan tetapi kita dapat
merubahnya ke Bahasa Indonesia dengan cara klik menu Settings > Options > pilih
tombol ‘Locale’ kemudian klik ‘override system locale’ dan pada menu ‘Locale use
instead’ pilih ‘Bahasa Indonesia’ kemudian klik tombol *OK’ dan tutup aplikasi
QGIS.

./ Options | Locale

% Ovdrride system locale

Note: Enabling / changing averride on local requires an applic

Additional Info

Detected active locale on your system: en_US

L!.:u Network.

Variables

Tampilan QGIS akan berubah menjadi Bahasa Indonesia, setelah kita buka kembali
aplikasi QGIS. Tampilan Graphical User Interface (antarmuka) QGIS yang terdiri dari
menu bar, toolbar, browser panel dan layers panel adalah sebagai berikut:
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[ qeis 21815 =
Project Edit Tampilan Layer Pengaturan Plugins Vektor Raster Basisdata Web Processing Bantuan Menu Bar
NEARRR[FHO@ L2 sHPO 4B =t

r: ° - oD P mice R B ? g =g = & g g fesw ﬁ)
Browser Panel 8 x
GRETHO \
8 [ 0 e Toolbars

f Favorit
a v ke
b

= D:f
Sy ey
@ | [ oe2

P mssqu
@ orade

~| @ postais
- /# spatalite

N

o]

%o | & Acdretrssenar Browser Panel

v, @ ArcGisMapserver

@ ows

Vv @ Tieserver povz)
=] @ wes

2 wrs

@ wms

Layers Panel & X

cAwTL-RHAL

™~

Layers Panel

Koordinat ¥ Skala 1:1,415,814 v Qb Maonifier 100% 5| Rotasi 0.0 2| [@lrender {DhEPSG:4326 @

Untuk menambahkan peta ke dalam QGIS maka langkahnya adalah: klik menu ‘Layer’
> ‘Tambah Lapisan’ > ‘Tambahkan layer vektor’ sehingga akan muncul tampilan
berikut:

1 Q@IS 2.18.15 - Peta Kemiski
Project Edit Tampilan | Layer | Pengaturan Flugins Vektor Raster Wweb

D Buat Lapisan 3
o B ny|

Bantuan

Processing

@ @ -[TFg -0, F

Tambah Lapisan r Cirl+Shift+v
7 o
;';{ | J Semathan layer dan grup... g Crlehle
v‘, Browser Panel Tambah dari Berkas Lapisan Definisi... .ﬂ Tambahkan Layer PostGIS... Ctrl+shift+0
AR TES sinstie #2 Tambahkan Layer Spatialite... Clrl+shift+

©) Direktori

() Basisdata ) Protokel

7\

N
m
AN 5 L v 4

Open
‘\_/

[system

Sumber

Dataset

Klik *‘Arsip’ pada pilihan ‘Jenis Sumber’ lalu klik *‘Navigasi’ untuk mencari direktori
tempat di mana peta dasar berada (C:\01_Pelatihan_FSVA \Peta).

Google Drive
D= [] Peta_Kabs14.shp
4 Libraries

= Documents

& Music

=] Pictures

B videos

i

¥ Homegroup

/M Computer
&, System (C)

_OUv| < System (C:) b 01_Pelatihan_FSVA » Peta [ 49 |[ Search peta 2|
Organize v New folder =~ 0 @
B Desktop - e Date madified Type

1/16/2018 11:48 AM  SHP File

D

o Date (B e

i ] v

File name:

ESRI Shapefiles (™

iSHP) -

\_/
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Di sini kita akan menggunakan file ‘Peta_Kab514.shp’, yaitu peta seluruh kabupaten
dan kota yang ada di Indonesia. Kemudian klik ‘Open’ sehingga akan muncul peta
Indonesia di ‘Layers panel’ seperti tampilan berikut:

GeRTE e
Project Edit Tempilan Layer Pengaturan Plugins Vektor Raster Basisdata Web Processing Bantuan

DEERBLRRFEISLALAHPPRASKLBIRS 6 K-8 -L,EEE=- - 0
Y /BRG-BRROSEE COEIVERDR &2

Browser Panel 8 x
Va JRY®O

o] 1\ Rumzh

v v D/

BEr8088NN
o

& ArcGisFeatureServer
\/ v| @ ArcGisMapserver
- @ ows
@ Tie Server (xv2)
@ wcs
Layers Panel 8 x
o % V&~ A0
EMeemrabsis ]

Koordinat 103.84,-16.38 ¥ Skala :19,502,462 v f@ Magnifier 100% & Rotasi 0.0 2] @Render @heErsG:4326 @

Cara lainnya untuk menambahkan peta yaitu dengan mencari direktori tempat di
mana peta dasar berada dengan mencari di ‘Browser Panel’ dan memindahkan file
peta itu ke ‘Layers Panel’ dengan cara di ditarik/dipindahkan.

.

Project Edit Tamplan Layer Pengaturan Plugins vektor Raster Basisdata Web Processing  Bantuan

D ..Q@.Q@&@ﬁ”;}g Rl
/BRI E "QORHYERGH|

Browser Panel -3

v‘; LeETHe

e -
f Favorit

CHRPRE
-O o > i 00_Dedi E

4 || 01_Pelatihan_FSvA
@ e > JJ Data
% > Layout

> . Logo

e » caiuze —
bl 142a751baf3e0d o .
83 > )l c5ae290bcfds61fbeatas7200 P|ndahkan ‘Peta_KabS 14. Shp’
\ff‘; - bl cTea3b80e96e211a85595b2715553a5 .

Ul casdsznzzb1rabfibanch dengan cara menariknya ke

b cf1596a7e691f2Hp49bbos4feb33af24 \ 2

S - - Layers Panel

Layers Panel & X

o @l ® T &, -3 R

v
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B. Mengubah penampilan/warna layer

Untuk merubah warna layer sesuai dengan kebutuhan kita, lakukan langkah sebagai

berikut:

1. Arahkan kursor ke ‘Layers panel’, lalu klik pada peta yang akan kita ubah
warnanya (Peta_Kab514) kemudian klik kanan dan pilih ‘Properti’.

2. Pada window ‘Properti layer’klik menu Style kemudian klik ‘Single symbol’ dan
tentukan warna yang di inginkan pada menu ‘Warna’ (contohnya warna coklat)
dan klik tombol *OK’ sehingga tampilan peta berubah menjadi warna coklat.

QGls 21815

= EE; 3 . .
D o] # Properti Layer - Peta_Kab514 | Style 2 \ B |
BRI = Singee symbol _/ -]
Ve Browser Panel TEErT A
o LET*o & sue Il Fengisian sederhana
= Rumeh
Favorit
Lo | he i
R - > )L 00 Ded —
Q 4 )| 01_pelathan_FSVA LA
@ h > Dsta
Satuan [niimeter ==
> ) Layout F
% . Transparansi 0% |
=L > )i Logo N
(\‘ra - a4 Peta Q; Warna 4’
- () Peta_Kabs]
% + [l sofware : i
0 142275 108304034 .
cSae290bcrdse1fsf{ |y | ‘..:
W o c7ea3bB0es6e21414 simbol dalam grup -
- casdszazzbizebdll U IR |
cf1596a7e691f2064 E
d37e239a20096e59) |; ‘

Layers Panel
o (1w TE&-% ]
M peta Kabsia |

¥ Proses Render Layer

Transparansi Layer &

[7] Draw effects

[T] Control feature rendering order

Gaya T

C. Menampilkan data atribut

Untuk menampilkan informasi atau data atribut pada suatu unsur spasial yang
terdapat di peta yang sedang kita tampilkan, kita dapat menggunakan cara-cara

sebagai berikut:

1. Klik tombol Identifikasi Fiturq’\* pada

button bar Toolbar.

2. Letakan kursor mouse di atas daerah yang ingin kita tampilkan informasinya/data
atributnya. Kemudian muncul kotak dialog “Identifikasi hasil” yang memuat
informasi atau atribut dari unsur yang kita pilih, seperti tampilan dibawah ini.
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Raster

Basisdata Web Processing  Bantuan

ey i oy oyeyeyi i~

= @) B oy o gy o e

ﬁjﬁﬂu T =
CSW ) 1
N

oT'

Tdentificasi hasi & x
HAF3=58
Fitur Nilai
4 Peta_Kab514
4 [FID_Peta K. 267
> (Berasal)
b (aksi)
FID_Peta_K 487
l Nama_Prov SUMATERA SELATAN
Nama_Kab OGAN KOMERING ILIR
Kode_Prov 16.00000000000
Kode_Kab 1602.00000000000
Tipe Kabupaten

Tampilan | Pehan
ad

ofd

Sedangkan untuk melihat data atribut yang terkait dengan peta yang sedang kita
tampilkan, kita dapat melakukan langkah berikut:

1. Klik kanan pada layer peta (Peta_Kab514) kemudian klik kanan dan pilih ‘Buka

Tabel Atribut’. Sehingga tabel atribut dari layer tersebut akan muncul.

2. Pada tabel atribut tersebut carilah record (baris) yang ingin kita ketahui lokasinya
pada layer, kemudian klik pada record tersebut. Contohnya: Kita akan mencari
lokasi Kab. Manokwari di dalam peta. Cari dan Klik record “Manokwari” di dalam

fields (kolom) “Nama_Kab"” sehingga akan muncul tampilan berikut:

/ PetaKab514:

{in_L%

4 E8 [ Ir L
Features total: 521, filtered: 521, selected: 1

74 o] o & *TESD a6 B =
FID_Peta K Nama_Prav Nama_Kab Kode_Prov Kode_Kab Tipe E
349 343 PAPUA KOTA JAYAPLRA  94.00000000000 $471.000000000... Kota
350 349 PAPUABARAT  FAKFAK 91.00000000000 8101,000000000... Kzbupaten
351 350 PAPUABARAT  KAIMANA 91.00000000000  3102.000000000.... Kabupaten
352 351 PAPUABARAT  TELUKWONDAMA  91.00000000000 9103.000000000... Ksbupaten

352 PAPUA BARAT

354 PAPUA BARAT

TELUK BINTUNI

91.00000000000  §104.000000000.

Kabupaten

SORONG SELATAN  91.00000000000 5108, 000000
FEES ReCOrd SORONG 91.00000000000 9107.00000000000 Kabupaten
: 357 356 PAPUA BARAT RAIA AMPAT 91,00000000000 §108,000000000... Kabupaten
B|3s8 357 PAPUA BARAT TAMERAUW 91.00000000000 9109.000000000... Kabupaten
:‘ 359 358 PAPUA BARAT MAYBRAT 91,00000000000 §110,000000000... Kabupaten O
360 359 PAPUA BARAT MANOKWARI SE...  91.00000000000 9111,000000000... Kabupaten I
q|3s1 350 PAPUA BARAT PEGUNLINGAN A 91.00000000000 $112,000000000... Kabupaten
] 351 PAPUA BARAT KOTA SORONG 91.00000000000 $171.000000000... Kota
383 352 RIAU KUANTAN SINGL 14,00000000000 1401,000000000... Kabupaten
2 353 RIAU INDRAGIRI HULU 14.00000000000  1402.000000000... Kabupaten
INMD ARTET HTL T, 14 001402 AOONAANOD— ¥abinate &

s 2 pian
T Tampikan Semua Fitur,

m
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II. MENGGABUNGKANDATA EXCEL DENGAN PETA

Untuk menggabungkan data pada file Excel (format: xls, xIsx, csv) dan peta QGIS ada
beberapa syarat yang harus dipenuhi, yaitu:

1. Data Excel dan QGIS mempunyai satu nama "field (Kolom)” yang sama sebagai
penghubung untuk proses penggabungan tabel ini.

2. Jumlah baris/record dan isi record pada field penghubung di Excel dan QGIS
harus sama dan identik contohnya ‘Kode_Kab’.

3. Kolom Excel pada baris paling atas digunakan sebagai judul kolom. Judul kolom ini
tidak dalam kondisi “gabungan/merger dari beberapa kolom”.

Untuk menggabungkan data Excel dengan peta QGIS lakukan langkah-langkah
dibawah ini:

1. Buka file data pada program MS Excel yang berisi indikator yang akan dipetakan.
Dalam hal ini file ‘Data_FSVA.xlsx" dan worksheet ‘Data’, yang berisi data
tentang Nama Provinsi (Nama_Prov), Nama Kabupaten/kota (Nama_Kab), Kode
Kabupaten/kota (Kode_KabKota) dan indikator FSVA yang akan digabung.
Field/judul kolom Kode_KabKota dijadikan sebagai penghubung file Excel
dengan peta QGIS (Perhatian: Kode kabupaten pada Excel harus sama persis
dengan kode kabupaten pada Tabel peta QGIS. Gunakan nama kabupaten pada
QGIS sebagai referensi/standar).

2. Usahakan nama sheet dan judul kolom tidak panjang, karena akan berimbas saat
tabel digabungkan nantinya, (maximal 10 karakter setelah di gabung).

3. Kemudian tutup lembar kerja Excel.

Data FSVA - Excel

Review  View  Help @ Tell mewhat you wantto do

u
o, X . = e A -
ne @ Calib 1 oA K - - EPWiap Text Nurmb 2 Autosum éY p
. Em Copy [ it~ ot Prd
o ot & Fin
¥ Format Painter | © 1 U oA ] Merge & Cent $ Clear~  Fifter Select=
Ciipboard & Font 5 Alignment 5 Number Editing -
R21 - fe 8,55723334600804
A ] c | o £ 3 a H | a K L w N R N
o) i (BRI ET v R T e T T T T e R
2 1A i a1 LEE] 80 153 ES 000 128 28 557 3650
3| zacen i 170 2150 s 020 S0 eoe 157 £ 283 a0 466
4 3 ACEH 1 015 1348 654 196 36.96 B3.75 263 3n 266 2362 44.30
5| aaceH n 008 .45 488 380 w0 e o2 i 7 21853 se56
6| sacen i oz 06 954 ot S0 eszs o7 184 EX) 3365 i
7 & ACEH 1 047 64 407 153 3745 6848 2,n 037 27 57,29 43,10
o | 7aceM i 3 203 1053 050 Wiz e1se 650 308 B EL] 2530
3 8 ACEH 1 o017 15,55 o017 0.70 20,78 6343 132 135 22 16,63 15.09
n 9 ACEH il 0w 21,25 150 0.94 5113 66,52 0.8 413 217 163 5278
W waceH i o6 % 608 248 ESI 043 102 35 18 2304
2 11 ACEH 1 015 1346 6.52 0.62 55.26 68.51 3.05 135 361 24,41 4327
I 12 ACEH il [55) 803 4,61 189 29,13 64,35 0.00 388 3E wn T04E
W ACEH i o0 2186 4 Tas - 83 s80 65 3551 053
5 14 ACEH 1 021 14.51 7.98 0.25 33.00 63.08 047 235 151 38.97 329
© | ®ACEH i [ 19,25 138 & EXC T 150 378 25 343 s5.34
w . mACEH i 3 w01 2o 000 33 w10 53 510 225 s 3028
18 17 ACEH 1 0.88 2143 343 017 30.67 68.85 172 104 38 46,78 2363
© | ACEH i o1 e 000 2,70 4 eess [ e T4 w7 03
20 13 SUMATERA UTARA 12 0.52 7,64 4412 38.80 G444 £3.07 15.88 872 198 4412 32,04
2 I 20 SUMATERA UTARA 12 021 10,98 10,07 1881 aE B1L77 4,31 118 28 At 7860
2| 21 SUMATERAUTARA 12 0 s 524 653 185 401 655 102 21 asar 7252
23 22 SUMATERA LTARA 12 0.22 458 6,51 5.68 4766 B6.62 4,13 133 308 24,65 63,64
24 23 SUMATERA UTARS. 12 04 .25 6835 6.62 36,53 BT 238 034 4 52,38 3482
s | 24 SUMATERALTARA 12 on 05 251 351 St 69zs o 4 23 arse 2302
6 25 SUMATERALITARA 12 0.36 8.5 12.24 34 23,87 63.40 102 043 302 376 4256

2
7| o5 SUMATERALTARA 12
2 | 27 SUMATERALTARA 12
28| 28 SUMATERALTARA 12
0| 23 SUMATERALTARA 12

abuhan Bat ;

a = X 3 y K : 1 2 z , z

S| 30 SUMATERAUTARA 12 ei3Ming 030 a6 154 005 BaT 706 026 044 4 34,70 st

32 31 SUMATERA UTARA 12 0% .36 5.05. 033 4141 67.73 1.08 115 254 44.40 20M |~
Data ® 71D

4. Dengan menggunakan QGIS, klik file excel yang akan digabung dalam folder
‘C:\01_Pelatihan_FSVA\Data’ dalam hal ini file ‘Data_FSVA.xlsx’ di
‘Browser Panel’ dan memindahkan file excel tersebut ke ‘Layers Panel’ dengan
cara di ditarik/dipindahkan.
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5. Mengingat di file excel tersebut ada 2 worksheets yaitu data FSVA dalam format
untuk laporan (worksheet ‘l. Data FSVA Kab-Kota 2017’) dan data FSVA yang
akan digabungkan dengan peta (worksheet ‘Data’) maka akan muncul jendela
pertanyaan ‘pilih layer vector untuk ditambahkan’, klik baris ke-2 dalam hal ini
worksheet ‘Data’ dan klik tombol ‘OK’.

7 Pilih layer vektor untuk ditambahkan... |2 s

ID layer Jumiah fitur Tipe geometri

520 None
514 None

O

o ) (mheme ) [ cmm

/1 QGIs 2.1815
Project Edit Tampilan Layer Pengaturan Plugins Vekior Raster Basisdata Web Processiny g Bantuan

DEBRER AL DD RSB &0
y - OB Pz T =€ w1 () [ g o oy gy | o
Browser Panel & X
VC: O&ETHO
- Rumah
.’6 ‘ Za:;/nr\t
‘D- > | 00_ped .
- ;
% ‘a vBo
.’Y‘c‘, - (3
% eta_rabfra.shp Pindahkan file excel‘Data
> Sofware
2} P — FSVA.xlsx’ dengan cara
Vit e o | menariknya ke ‘Layer Panel
ca! f2baa; H 3 H \
s | S€hiNgga menjadi layer *Data
Layers Panel & FSVA Data,.
o @ w T & WO '
E‘
1 I petn Kabss *y

6. Mengingat ada keterbatasan jumlah karakter pada judul kolom yang akan digabung
(maximal 10 karakter setelah di gabung), maka layer ‘Data FSVA Data’ harus
di ubah namanya (rename) ke nama yang lebih pendek yaitu dengan cara klik
kanan pada layer tersebut lalu pilih ‘ubah nama’ dan ketik nama yang lebih
pendek (contohnya dari ‘Data FSVA Data’ menjadi ‘D).

Perbesar ke Layer

Da  Showin Overview

[l Buang

5, Lay ] Duplikat
&g~ L4 Siyle 5
Pe|
% Buka Tabel Atribut
Sol
Toggle untuk mengedit
Ya 142a7§ * .gg N 9
W csse2d  Simpan sebagai..
- Tea] Simpan Sebagai Berkas Lapisan Definisi...
casdsd Saring...
cf1536, Tampilkan Jumlah Fitur
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7. Kemudian klik pada layer peta (Peta_Kab514), pastikan tidak ada
kabupaten/kota yang terpilih dengan cara klik tombol ‘Pilih [i fitur
berdasarkan wilayah atau satu klik’ diluar peta sehingga tidak ada peta yang

berwarna kuning (terpilih).

8. Selanjutnya klik kanan pada layer peta (Peta_Kab514) dan klik ‘Properti’.

9. Pada window ‘Properti layer’ klik menu Gabung kemudian klik tombol klik
“tambah penggabungan.. ”. (Tanda “Tambah” warna Hijau di kiri bawah).

J| # Propeti Layer - Peta_Kab514 | Gabung -

‘ ) @ - )
d 5]
Bronser Fanel Layer yang digabur Field yang digabunc Field target Memori Cache  Prefix Joined fields
LeTme
Rumsh
Favorit
o €17 Label
00_Ded
01_Pelatihan_FSVA BB ried
4 | Deta
o | 4 Merender
Layout
Logo , Tampilan 2
4 | Peta
(0 Peta_Ksbs 1 c@ Tndakan
> | Sofware
142a75 1b&f3eD
> | cSae290bcfdss1f3r
> | c7eadbB0eg6e21414 =
> casds28220172bd2t P8
cF1596a 7269172064
i
(T &~ 3.
E a
. . Peta Kab514 |}
R:
—

10.Pada jendela ‘Tambah penggabungan vektor’ pilih ‘D’ di kotak dialog ‘Lapisan
yang akan digabungkan’, kemudian pilih '123Kode KabKota’ di kotak dialog
‘Field yang digabungkan’ dan pilih 1.2 Kode_Kab’ pada kotak dialog ‘Field
target’. Kemudian pilih/centang ‘Cache lapisan...” dan lalu klik tombol *OK".

Nama worksheet dari Excel
/ Tambah penggabungan vektor

Lapisan yang digabungkan
Field yang digabungkan [;3 Kz€KabKoB ) x ] @ KO |Om darl EXCG|
Field target -

123 FID_Peta K

o
Cache)lapisan yang digabung dalam memari virt
abc Nama_Prov

~ indeks atribut pada field yang digabung | abe Nama_Kab
oose which fields are joined 1.2 = KO IO m dal’l Peta
4 stom field name prefix al

C) =0

11.Kemudian akan muncul hasil sebagai berikut dan klik tombol *OK" untuk mengakhiri
proses ini:
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/| Properti Layer - Peta_Kab514 | Gabung - el x|

Field target  Memori Cache  Prefix  Joined fields
Kode Kab v semua

ngkan  Field yang diga

Kode KabKota

& Merender

, Tampian
(,!a Tindakan

IER viogram
@ reia
variables

.-
= Legenda

12.Hasil dari proses ini adalah tabel data dari Excel dan peta QGIS yang sudah
digabung (lihat gambar dibawah ini).

Data dari Peta QGIS Data dari Excel
A A
e N N

(7 Pets_kabsia:

&

[ ~ L] @ =
Kode_Prov Kode_Kab Tipe D_No. D_Nama Prov D_Kode Prov D_Nama Kab D_1_NCPR D_2POVERTY  D_3ROAD_1S  D_4FLECTRIC D_5_WATER

1 11,00000000000  1101,000000000... Kabupaten 1 ACEH 11 Simeulue 0.407422308759... 19.925784157305 5.797101449275... 1.532187837162... 26.14702958292
2 11,00000000000  1102.000000000... Kabupaten 2 ACEH 11 Aceh Singkil 1.743018343774.. 21.602204674283 9.166666666656... 0.197094308769... 50.00987915178
3 11,00000000000  1103,000000000... Kabupaten 3 ACEH 11 Acsh Selstan 0.154288718116... 13.47661631142 6538461536461, 1.957349054209... 36,95993678985
4 11,00000000000  1104,000000000... Kabupaten 4 ACEH 11 AcchTenggara  0.064466605814.. 14.455051917708 4.675324675324.. 3.842403103923 45.60295736832
5 11,00000000000  1105.000000000... Kabupaten 5 ACEH 11 Aceh Timur 0.202852731573... 15.05906676167... 9,338521400778... 3.065851460585... 53.01161602026
s 11.00000000000  1106.000000000... Kabupaten 6 ACEH 11 Aceh Tengah 0.469324889453... 16.63833342120... 4.067796610169... 1.530714828834... 37.4511676612081
7 11,00000000000 1107.00000000000 Kabupaten 7 ACEH 11 Aceh Barat 0.181477349778... 20,37514561636... 10.59190031152... 0.898702565035... 30.72286755722
8 11.00000000000  1108.000000000... Kabupaten 8 ACEH 11 Aceh Besar 0.174655541320... 15.55241453630... 0.165562913907... 0.698194679477... 20.77927333471
E] 11,00000000000  1108,000000000... Kabupaten 9 ACEH 11 Fiddie 0.169973642553... 21,25258640580... 1.504787961696... 0.941385123640... 51.13096433862
10 11.00000000000 1110.000000000... Kabupaten 10 ACEH 11 Bireven 0.178893604364... 15.95082406322.. 6.075533661740... 2.484778054283... 34.99957541808
11 1100000000000 1111.000000000... Kabupaten 11 ACEH 11 Aceh Utara 0.151492422579... 19.46297721877... 6.524882629107... 0.615602601296... 55.27923187999
12 11.00000000000 1112.000000000... Kabupaten 12 ACEH 11 AcchBaratDaya  0.145784301014.. 18.03356568501.. 4.605263157894.. 1892649171489... 29.12922318140
13 1100000000000 1113.000000000.. Kabupaten 13 ACEH 11 GayoLues 0.138541016408... 2186019665301, 4137931034482 1.452257056356... 57.9851991333763
14 1100000000000 1114.000000000... Kabupaten 14 ACEH 11 Aceh Tamiang 0.207385632763... 14.50587052662.. 7981220657277 0.247976964604... 33.00718065711
15 1100000000000 1115.000000000... Kabupaten 15 ACEH 11 Nagan Raya 0.115854840151... 19.24699164330... 1351351351351 1.1338726574339 31.45714749109

13.Walaupun sudah tergabung, namun data diatas belum tersimpan, jadi data
gabungan itu masih menempel sementara pada layer Peta. Jika kita buka lagi layer
tersebut maka akan hilang hasil proses penggabungan ini. Oleh karena itu hasil
proses ini perlu di simpan dengan cara klik kanan pada layer ‘Peta Kab514’ dan
klik 'Simpan sebagai’.

14.Pada jendela ‘simpan layer vektor sebagai’ pilih ‘ESRI shapefile’ di kotak dialog
‘Format”, kemudian klik “navigasi’ lalu arahkan ke direktori kerja kita
(C:\01_Pelatihan_FSVA\Peta) dan beri nama peta hasil join ini contohnya
‘Join FSVA' dan klik tombol ‘OK’. Di jendela ‘simpan layer vektor sebagai’ klik
tombol *OK’ untuk mengakhiri proses ini.
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/! Simpan layer vektor sebagai... /\ LD |l

K
1)
Fomei  [ESRI Shepefie _/ ,\[\
Il Fename = #FSvA Peta/loin FSVA.shp >@

Layer name

CRS ‘ Selectad CRS (EPSG:4326, WGS 84) - ‘\__|

Pengkodean [system -]

b select fields to export and their export options

W] Tambah berkas tersimpan ke dalam peta

Ekspor smbolagi Tidak ada smboiog

¥ Pilihan Lapis

RESIZE O -]

sHPT | -]

» Pilihan Penyesuaian @

g—

Q oc | ) caneed | [_Heb
4

III. MEMBUAT PETA TEMATIK

Pembuatan peta tematik dilakukan berdasarkan indikator-indikator yang telah kita
tentukan. Dengan menentukan range (batasan selang nilai) suatu indikator, kita dapat
menyusun tingkat kerentanan pangan wilayah. Sebagai contoh, kita ingin memetakan

indikator ‘persentase penduduk yang hidup dibawah garis kemiskinan’
berdasarkan range indikator berikut:

= Prioritas 1: >=35%

= Prioritas 2: 25-<35%

= Prioritas 3:  20- <25 %

= Prioritas4: 15- <20 %

= Prioritas 5: 10- < 15%

= Prioritas6: 0-<10%
Maka langkah-langkah pembuatan peta tematik berdasarkan indikator kemiskinan
(field: ‘D_2_POVERT"’) adalah sbb:

1. Buka software QGIS tampilkan sebuah layer yang akan dibuat peta tematik-nya
(Join FSVA.shp) pada ‘layers panel’.

2. Klik kanan pada layer Join FSVA.shp lalu klik ‘Propertis’.
3. Pilih‘Style’ lalu ganti symbol tunggal dengan ‘Graduated’.
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# Properti Layer - Join FSVA | Style
S

Gmuim

“
o )t

ST bl Graduated

= Berdasarkan aturan
8 roligon terbalik
Ef Field NE 250 |

& Merender
@ i
JOR

Color ramp

Kelas | Histogram

Simbol Nilai Legenda

4. Maka akan muncul kotak dialog ‘Style":

1. Gantilah symbol tunggal menjadi graduated.

2. Gantilah kolom dengan field yang ingin kita kelompokkan (dalam kasus ini
kita ini kita ingin mengelompokkan indikator kemiskinan ‘D_2_POVERTY").

3. Masukkan jumlah kelas yang di inginkan, sesuai dengan panduan FSVA,
maka kemiskinan di kelompokkan menjadi 6 kelas yaitu:
i. Prioritasl1: >=35%
ii. Prioritas2: 25-<359%
i. Prioritas3: 20-<25 %
iv. Prioritas4: 15-<20 %
V. Prioritas5: 10-<15 %
vi. Prioritas6: 0-<10 %

pr ey - ¥ e

[ = Graduated ) v]:

Kolom @_POVED m -

Simbol [ [ ubah. .. |

FormatLegenda %1 - %2 Predsion 1 [ [T Trim

Metode [Color - ]
Color ramp -[scurce] v] [ Edit ] [ Balik

Simbor Nilai Legenda
] 1.669-8.909  1.6688 - 8.9090 U |
| 5.009- 16.149  .9090 - 16,1493

O 16,149 - 23,390 16,1493 - 23,3335

Matks /(= 1)
[oen

Link dlass boundaries

m

5. Selanjutnya adalah langkah-langkah menyesuaikan nilai pengelompokan indikator
kemiskinan menjadi 6 kelas seperti diatas:
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Kelas Hlsmgram

e —
1 Masukkan batas-batas... l P

Legenda
6688 - 8.9039

B30 37.870 30.6298 - 37.8701
37.870 -45.110 37.8701-45.1103

Link dlass boundaries

P Proses Render Layer

o) (o) o ) o
A

1. Klik 2x pada kolom *Nilai’ di kelas teratas dibawah nilai, maka akan muncul
kotak dialog ‘Masukkan batas..’

2. Pada kotak dialog ini masukkan nilai-nilai sesuai kelas yang ditentukan,
contohnya untuk mengisi prioritas 6 maka:

e Nilai inferior (nilai terendah): 0
« Nilai Superior (Nilai tertinggi): 9.9999 (karena nilainya < 10)

3. Klik 2x pada nilai di kelas teratas dibawah ‘Legenda’, dan ganti tulisan itu
dengan ‘< 10’

4. Klik 2x pada box warna teratas di bawah kolom ‘Simbol’, maka akan muncul
kotak dialog ‘Symbol selector’:

e Pada kotak dialog '‘Symbol selector’ klik 1x pada kotak ‘warna’
sehingga muncul table dialog ‘Select Color’.

e Kemudian tentukan komposisi warna RGB untuk indikator kemiskinan
contohnya untuk range kemiskinan <10% (Prioritas 6) maka komposisi
warna RGB nya adalah Red: 59 Green: 112 Blue: 59 lalu klik tombol

\ (4
oK'.
€ o @ B » . 9. 7] % Nasiaies 0, e = -G [T~
LL:,NG JL@ZMO n
E=I - -
5 Pengisian sederhana / Select fill color lea- e
] W ol o E o
[

Tipe layer simbol
il
Outine

Style pengisian

Gaya garis luar
‘

| HTML notation  #3b703

0 | e

DDDD@]D
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o Untuk pewarnaan di kelas lainnya menggunakan pola warna RGB sebagai

berikut:

Prioritas Red Green Blue
Prioritas 1 (#6elf1f) 110 31 31
Prioritas 2 (#e85961) 232 89 97
Prioritas 3 (#f4ala7) 244 161 167
Prioritas 4 (#c9e077) 201 224 119
Prioritas 5 (#94c945) 148 201 69
Prioritas 6 (#3b703b) 59 112 59

6. Sehingga hasil pewarnaan untuk kelas kemiskinan prioritas 6 (< 10) adalah sebagai
berikut:

Nilai LegendN

0.000000 - 5.993500 0] )
£,995900 - 16, 149286
= 16,1 n
] 23,389545 - 30,629805
] 30.629805 - 37.870064
|

37.370064 - 45.110324

.1493 - 23,3895
23,3895 - 30.62%8
30,6298 - 37.8701
37.3701-45.1103

7. Lakukan kembali langkah-langkah di atas untuk 5 kelas kemiskinan lainnya dengan
cara yang sama (perhatikan Nilai tiap kelas, Legenda label, Simbol warna
RGB) sehingga hasilnya akan seperti gambar berikut:

Kelas Histogram

Simboi Milzi Legenda
] . 0.000000 - 10,000000 < 10

] |:| 10,000000 - 14.999959 10 -<15
] |:| 14,999999 - 19.9999599 15-<20
] |:| 19,999999 - 24,9999599 20-<25
] . 24,9995999 - 34,999990 25 -< 35
] . 34,999590 - 100.000000 > 35

8. Untuk memudahkan proses pewarnaan, QGIS memberi kemudahan dengan proses
penyimpanan style warna (RGB) sehingga kedepannya jika ingin memilih warna
yang sama kita tidak perlu lagi mengisi kode RGB satu per satu, caranya adalah
sebagai berikut:

1. Setelah pewarnaan untuk 6 kelompok selesai, klik 2x pada box warna
dibawah kolom ‘simbol’ sehingga akan muncul kotak dialog ‘Simbol
selector’.

2. Klik tombol ‘Simpan’ sehingga muncul kotak dialog ‘Nama simbol’,
mengingat warna ini untuk range di kelompok Prioritas 6 maka beri nama
‘P6’ kemudian klik OK sehingga warna dan nama simbolnya ada di dalam
box ‘simbol dalam group’, lalu klik OK.
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Simbol [ / Symbol selector ? =
Format Legenda %1 - %2 4 . Fill
Metode [Cclor . Pengisian sederhana .
Color ramp - [source]
Kelas Histogram | L AT
o aenda Satuan [M\I\meber hd ]
‘ [ @m‘oooooo <10 }
—onf00 - 14.999999 10 - < 15 Tansparansi 0% |
O 14999999 - 19.999999  15- < 20 e
O 19.999999 - 74.999999 20 - < 25
| 24.999999 - 34.999990 25- < 35
| 34.999990 - 100.0000. > 35
‘,/' ——— ) 53 Simbol dalam grup -
P
P Proses Render Layer 1 7 Si \ PP
J
N O
3. Lakukan untuk 5 kelompok lainnya sehingga warna yang tersimpan sebagai
berikut:
Simbol dalam grup -
[ P2 P3 P4 P5 P6& _‘
'

4. Apabilaingin melakukan pewarnaan untuk indikator FSVA lainnya, maka kita
tinggal memilih pallet warna yang telah kita buat sebelumnya (P1-P6).

Setelah proses pewarnaan peta selesai, kita lakukan perubahan nama layer ‘Join

FSVA'’ sesuai dengan indikator yang kita petakan. Caranya adalah klik kanan pada
layer *Join FSVA'’ lalu klik ‘Ubah nama’ menjadi ‘% Penduduk Miskin’.

10.Maka hasil proses pewarnaan peta yang kita kelompokan berdasarkan kriteria
kemiskinan FSVA tampilannya adalah sebagai berikut:

f Rumah
3] Faverit
@ .|« by
£ > )l 00_Dedi
-] o L oipdathenroia
% Data
S Layout
[ ! Logo
Peta
°, e
%4 4 Lathan.ags
o B Modul QGIS_lan18.pdf
\f( - 3 Modul QGIS_lan18.pdf
: 142375 1b8f8e0403cfdf73f60
€5ae290bcfd56 1f8f3beata87200
c7ea3bBedte2141a8550502715553a5  ~
Layers Panel & x
ST - TN
4 [¥] O 2% Penduduk miskin
[ et
[] 15-<20
[] 20-<25
[ 25-<3s
W--=
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11.Langkah selanjutnya adalah memberi label nama provinsi atau kabupaten dan
kota. Mengingat ada sebanyak 514 kab/kota maka kita akan menampilkan label
nama provinsi agar petanya tidak penuh dengan nama kab/kota. Lakukan langkah
berikut untuk memberi label nama provinsi:

1. Buka peta batas provinsi di folder *C:\01_Pelatihan_FSVA \Peta\Batas
Provinsi.shp’ dengan cara menarik atau memindahkan dari ‘Browser
panel’ ke ‘layers panel’. Letakkan peta batas provinsiini di atas layer peta
kemiskinan.

2. Klik kanan pada layer ‘Batas Provinsi’ kemudian klik ‘Properti’ lalu klik
tombol ‘Label’ dan lakukan langkah berikut:

» Ubah drop bar menu paling atas dari ‘No labels’ menjadi ‘Show
labels for this layer’.

» Pada kotak ‘Label with’ pilih field yang ada hama-nama provinsi yaitu
‘Nama_Prov'.

= Ubah jenis huruf, style, ukuran, warna font atau latar belakang
font/penyangga sesuai yang kita inginkan kemudian klik ‘OK'.

n@

SR =0

3. Mengingat layer peta batas provinsi berada di atas peta kemiskinan oleh
karena itu kita perlu merubah style warna peta batas provinsi. Langkahnya
adalah sebagai berikut:

= Klik kanan pada layer ‘Batas Provinsi’ kemudian klik ‘Properti’ lalu
klik tombol ‘Style’.

» Klik pada ‘Pengisian sederhana’.
» Pada menu ‘Fill’ klik ‘Transparent fill’ kemudian klik ‘OK’.
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A Properti Layer - Batas Provinsi [ Style

= Single sk

|
Pengisian sederhana

IIM

Tipe layer simbol
Fill

Trangbarent fill

Outiine

Style pengisian

S— ‘

o

Gabung gaya

Lebar garis tepi
¥ Proses Rend

Transparansi Layes

Modus Penmmpur}

[] Draw effects

sepert| pada tampilan berikut:

. Rumah proyek E
b L Rumah
Favorit
a oy
> 1L 00 Ded
4 || 01 pelatinan_FSvA
> )l pata
b Layout
>}l Logo
4 | pet
£ Batas Provinsi.shp
(9 JoinFsva.shp
(9 peta_KabS14.shp
b} Sofware
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s
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NEE
[ EES

<15
<20
<25
<35
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] &
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==
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4
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|
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DKINakarta,
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=

Hasil proses pemberian nama provinsi dan pewarnaan batas provinsi adalah

i

"
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&
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q 2%
S
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12.Sebelum memulai proses pembuatan layout peta di QGIS, simpan file hasil
kerja ini dengan cara klik menu Project > Simpan sebagai.. kemudian
simpan di dalam folder ‘C:\01_Pelatihan_FSVA \Layout’ dengan nama
‘Peta Kemiskinan’ lalu klik tombol ‘Save’ seperti pada gambar dibawah.

'/ Pilih satu nama arsip untuk menyimpan sebagai arsip proyek QGIS (=5
Plugi @Qv‘ |« System (C:) 01 Pelatihan FSVA + Layout + [ [ search Layout 2l
Cel+n E: Organize v New folder = @
cl+o 5 Documents Neme Date modified Type
3 & Music
P— K 5 Pictures No items match your search.
B videos
Ctrl+s B
Simpan sebagai... Ctrl+5hift+5 & Homegroup L
. Save asImage... T
—— ™ Computer B |
&, System (C:
DWG/DXF Import... M Systenn (G}
s Data (D)

A\ ProjectProperties... Ctl4shiftp B nuam [ t
. File nanf: Peta Kemiskinan FSVA ) -
| New Print Composer curl+p
- erkes QIS (*.qgs "0 -]
<] Pengaturan Compose...

Print Komposer »
—
Keluar QGIS ctrl

D e i | @ bideraies o) |

TP _ ~—

&
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IV. MEMBUAT LAYOUT PETA

Setelah proses pembuatan peta tematik (indikator kemiskinan) selesai dilakukan, maka
selanjutnya kita akan menyajikan peta tersebut dalam sebuah layout peta. Didalam
QGIS sudah terdapat sebuah tool yang bisa melakukan pengolahan penyajian peta
yang disebut ‘Map Composer’, berikut adalah langkah-langkah untuk membuat
layout peta di QGIS:

1. Klik menu Project > New Print Composer sehingga muncul kotak dialog
“Judul Komposer”.

2. Beri judul layout composer-nya sesuai dengan peta tematik yang telah kita buat
sebelumnya yaitu ‘Peta Kemiskinan’ kemudian klik *OK’ sehingga muncul
poser di gambar dibawah ini:

[ smpan ctrl+s

[ Simpan sebagai... Crl45hift+5 [ | @ -]
S SavessImage... ¥ Judul Kompaser A . é]

Ekspor DXF... I
HIE T Buat judul komp: jang unik
| B oper e Cirl4shift+? jLideirmetes s apabila dikosongkan)
lew Print Composer Ctrl+P Peta Kemiskinan -
gaturan Compo N\

y ((Coc I ] |
~._
.

cul+Q

7 Peta Kemisin an = ol

penntah
<enoty>

L - nsLPLROW
o | R Bt B P e B e B e By B RE P B0, PSR L] reeretpera
D) S eret

Komposs | Propert ltem | Pembusten ates
Propert Ttem

3. Langkah selanjutnya adalah menambahkan peta dan komponen peta lainnya
seperti legenda, judul peta, skala, logo, arah utaradil.

4. Untuk menambahkan peta ke dalam composer, langkahnya adalah sbb:
1. Klik menu ‘Layout’ lalu pilih*Add Map’.

2. Klik di bagian kiri atas map composer yang kosong, klik dan tahan hingga
membentuk box seperti gambar di bawah ini (pastikan ada jarak/margin
dari tepi map composer.
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BOQOR D R e =6 s BA LT (LR k=5 /B R,
o [0 [ [0 [0 [ [ [ [s [ [ies [iio [t |15 [0 [1%0 [0 [1% [0 (18 [ia [ao [ia0 [0 [ |2 [ae [ i [0 [Rr——
canpty>

Kowpasis | Propertifiem | Pembuatan atiss
Kemposs

 Kertaa dan buaitas
Preset A4 (2105297 )

3. Maka ketika mouse kita lepas, maka secara otomatis muka peta

terpindahkan di composer.
4. Langkah selanjutnya adalah memberi garis tepi (frame) peta dengan cara
mengaktifkan layout peta dengan meng-klik peta hingga muncul 4 box di

tiap ujungnya.
g R Y g ™ a ke V MNP TN E @S W v
B Bt R R P20 B2 B 0, e fpwo, P B e, pe B B

5. Klik pada ‘Properti Item’ (dibagian kanan composer). Centrang pada
‘Frame’ lalu atur ‘Warna frame’ dan ‘Ketebalan Frame’ sehingga

petanya sekarang telah memiliki garis tepi/frame.

Kompofisi | Propertiltem | Pembuatan atias |
Properti [ x
Peta0 m
\ 1 , -
b || Dikontrol oleh atlas

P Raster-raster

P Overviews

P Posisi dan ukuran

n

» Latar belakang
P IDItem

b
w Variables
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5. Untuk menambahkan grid peta ke dalam composer, langkahnya adalah sbb:
1. Klik pada ‘Properti Item’ (dibagian kanan composer). Centrang pada

Aml,

‘Raster-raster’lalu klik pada tombol ® sehingga muncul tulisan ‘Grid
1’, Ubah Jenis Grid menjadi ‘Silang’ kemudian atur interval grid yang di
inginkan (contohnya X: 10 dan Y: 10).

Peta 0

Komposisi| ‘ Properti Item | em) asl
Properti Item 1 x

Dikontrol oleh atlas

’3(33” :

Gnd 1
w [V] Draw "Grid 1" grid

Jenis grid

m

/\

Satuan interval

Interval

2. Selanjutnya atur posisi label dari koordinat di grid yaitu dengan
mencentrang pada ‘Gambar Koordinat’ untuk ‘Format’ pilih ‘Desimal’
kemudian sesuaikan posisi label kiri/kanan/atas/bawah seperti pada
contoh dibawah ini.

v Gambar koordinat

Format [Desimal hd ] &

Kiri [Show all A ]

[Diluar figura - ]

[Uerﬁcal ascending - ]

Kanan [Show all A ]

[Diluar figura - ]

['derh'cal ascending - ]

Atas [Show all A ]

[Diluar figura - ]

[Horizonial - ]

Bawah [Show all A ]

[Diluar figura - ]
r

3. Jenis huruf/font dari label di grid juga dapat disesuaikan. Kemudian presisi
dari label grid di ubah ke ‘0" seperti pada gambar dibawah ini.

Huruf [ Huruf... ]

Jarak ke figura
peta

1.00 mm

Presisi koordinat 0
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4. Hasil dari proses ini adalah seperti pada gambar dibawah ini.

6. Langkah selanjutnya adalah mengatur posisi peta di composer agar sesuai
dengan yang kita inginkan, langkah-langkahnya adalah:

1. mengaktifkan layout peta dengan meng-klik peta hingga muncul 4 box di
tiap ujungnya.

2. Klik menu ‘Layout’ > ‘Move Content’ lalu geser posisi peta ke
atas/bawah atau ke kiri/kanan.

7. Kita juga dapat memperbesar atau memperkecil skala peta dengan cara klik pada
‘Properti Item’ (dibagian kanan composer). Pada menu ‘Properti Utama’ ubah
ukuran skala sesuai dengan yang kita inginkan, contohnya dari skala 25,703,183
menjadi skala 25,000,000 seperti gambar di bawah ini:

W Properti Utama

|Cacha _p— hd | ‘Perbaru\ prahnjau‘

N
Skala 25703183 a
Rotasipeta 0. = @
V| Gambar item kanvas

8. Menambahkan kotak untuk tempat judul peta, legenda, skala dll dilakukan
dengan cara berikut:

1. Klik menu ‘Layout’ > ‘Add Shape’ > ‘Tambahkan persegi panjang’.

Atlas  Pengaturan
o AddMap
T4 AddLabel
'| =3 AddScalebar
i3, AddLegend
% AddImage
1 Add shape » .
[ Add Nodes Item ¥ |/, TEMmsshian Segitioa

o Add Arrow & Tambahkan Elips
o Add Attribute Table

&, Add HTML I

2. Klik di bagian kanan atas map composer yang kosong, klik dan tahan hingga
membentuk box seperti gambar di bawah ini:
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3. Ketebalan dan warna kotak ini dapat kita ubah dengan cara klik pada
‘Properti Item’ lalu pilih ‘Properti Utama’, klik ‘Ubah’ untuk merubah
ketebalan dan warna nya, contohnya warna outline *hitam’ dan lebar garis
tepi '0.5" kemudian klik *OK’.

Shape telah ditambahian
s 2 ﬂh‘ Item telsh dihapus
# agis-bin 3 Shape teloh citambahkan
il (4
[ Pengisian sederhana /\
Kompossi Properti Ttem embuatan atias
Propert Tter X
= = Bentuk
() (=] (@] (@
w Properti Utama
Trmmer e [Pengisian sederhana A [Perseaipanjana yd -
L 1 2
| Fi I—‘I @ Radius sudut  0.00 mm 2
— Gaya Ubzh...
Y outine I ) I N L) 4 J
Style pengisian Soiid - ‘Er P Posisi dan ukuran
P Rotasi
Gaya garis luar |—— Garis padat vJ €
P IDItem
Gabung gaya gy Miter vJ =N -
Lebar garis tegf 0.500000 2 [Mimeter  ~| = P variables
f nnAnnn =1 [Milmeter — ~1]
5
4

9. Menambahkan judul peta dilakukan dengan cara berikut:

1. Klik menu ‘Layout’ > ‘Add Label’ kemudian letakan kursor nya di dalam
kotak di sebelah kiri peta sehingga akan memunculkan menu ‘Properti

Item’.

2. Ketik judul peta ‘Penduduk hidup di bawah garis kemiskinan’ di kotak
‘Properti Utama’.

3. Ubah jenis, ukuran dan warna huruf dengan klik ‘Huruf di kotak

‘Tampilan’ setelah itu klik ‘OK’. Kita juga dapat merubah posisi judul peta
(rata kiri, rata kanan atau rata tengah).
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/' SelectFont

Fontstyle Size
Bold 14

| [ Normal [
Bold 7
Ttalic 8
| | AntiqualnGrid Bold talic 9
AntiqualnGridBalloons 10

Sample

: naerine AaBbYyZz
[Ar\y 2 @ Horl.zoma\méfg\r\ 1.00 mm
Dﬁ( [ﬁcanm\ Vertl.cal margin 1.00 mm

[ e.n @ Tengah >m
10.Menambahkan skala peta dilakukan dengan cara berikut:

1. Klik menu ‘Layout’ > ‘Add Scalebar’ kemudian letakan kursor nya di

dalam kotak di sebelah kiri bawah peta sehingga akan memunculkan menu
‘Properti Item’.

2. Ubah Style ‘Kotak tunggal’ menjadi ‘Kotak ganda’. Untuk satuan unit
‘meters’, label for units ‘km’.

3. Ubah segmen skala menjadi ‘kiri 1’ dan ‘kanan 1’ dan untuk kotak

Fixed width isi dengan 500,000 (artinya 1 kotak di peta sama dengan
500,000 meter pada kondisi actual di bumi).

komposid| | PropertiTtem | Jbey q
Properti Ite X

Skala balok

~ - p

Maff [Peta 0 \ |

N 2
——

¥ Satuan

Scalebar units [ Meter -

Label unit multiplier - 1000,000000 2
Label for units km

¥ Segmen

Segmen 3

@ Fixed width

(©) Fit segment width

Tinggi

11.Menambahkan legenda peta dilakukan dengan cara berikut:

1. Klik menu ‘Layout’ > ‘Legend’ kemudian letakan kursor nya di dalam

kotak di sebelah kiri tengah peta sehingga akan memunculkan menu
‘Properti Item’.

2. Judul legenda dapat diganti menjadi ‘Keterangan’ atau tetap sesuai
dengan standar saja yaitu ‘Legenda’.

1-22 Pemetaan FSVA-Quantum GIS



7~ N\
Komposis Properti Ttem Pe miby
Legenda

W Properti Utama e

Judul Legenda
— -
Peta Petau

Pisahkan teks pada \/

Resize to fit contents

¥ Item legenda

Perbarui otomatis Perbarui semua

[ satas provinsi

4 [ 9% Penduduk Miskin
<10
0-<15
15-<20
M-<25
25-<35
»35 -

3. Ubah jenis, ukuran dan warna huruf dengan klik ‘Huruf’. Kita dapat
merubah huruf judul, huruf sub grup, huruf grup dan huruf item.

| s | Fw e | e sues |
7 Select Font = ) properu ien
— Legenda
Font style Size
Normal 12
Normal 6 n
Bold 7 ‘ ‘
= el 8 B - -
Bold Italic 9 viAld z g
1‘1] 7] Oriy show items inside current atlss festure
&2 ¥ Huruf
1
16 i ! Huruf judul... l ( 1
Sample [ N ——
[ Huruf grup... ]
AaBbYyZz [ = ]
Writing System urutitem.
v

& B L wama oot (-
)= ‘3)

(P

12.Menambahkan logo BKP dilakukan dengan cara berikut:

1. Klik menu ‘Layout’ > ‘Add Image’ kemudian letakan kursor nya di dalam
kotak di sebelah kiri tengah peta (dibawah judul peta) sehingga akan
memunculkan menu ‘Properti Item’.

2. Klik pada ‘'Sumber gambar’ dan arahkan ke lokasi direktori dari logo BKP

yaitu ada di ‘C:\01_Pelatihan_FSVA \Logo’ klik file ‘Logo BKP’ dan klik
‘Open’.

3. Kemudian atur penempatan logo tersebut ke ‘Tengah Atas’.

Gambar telah cigant
i arsip gambar . [ =
P Ubsh ukuran item Bl

<« System (C:) » 01_Pelatihan_FSVA » Logo = [ 44| search Logo o | [JE2cmeien ganbac henibah Z

— | kompasis | PropertiTtem | pembuatan atias
New folder =~ 0 @ Propert Ttem x
- Gambar

tes m
banery j o ¥ Properti Utama
ant Places Sumber gambar
Drive \—j C:/01_Pelatihan_FSVA/Logo/Logo BKR.png B (=8
phox NorthArrow 02 Mode ubah ukuran L
o 3

5 [Perbesar ¥
gle Drive
ies
uments m
ic
ures
103

File name: - Files (" So— -
B3| e
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13.Untuk menampilkan arah mata angin lakukan langkah berikut:

1. Klik menu ‘Layout’ > ‘Add Image’ kemudian letakan kursor nya di dalam
kotak di sebelah kiri bawah peta (diatas skala) sehingga akan memunculkan
menu ‘Properti Item’.

2. Klik pada ‘Direktori pencarian’ sehingga akan muncul pilihan gambar
arah mata angin. Pilih arah mata angin yang di inginkan dengan cara
meng-klik gambar arah mata angin yang di inginkan.

| Komposisi | Properti Item | Pembuatan atlas |
Properti Ttem =
Gambar

-

¥ Properti Utama

Sumber gambar

Mode ubah ukuran

[Perbesar - ]

Penempatan

Kiri atas 7

< ¥ Direktori pencarian

\ r

14.Untuk menampilkan catatan terkait sumber data dari peta atau instansi
pembuat peta dll, maka lakukan langkah yang sama seperti pada saat
menambahkan ‘Judul Peta’ diatas.

15.Hasil proses pembuatan layout peta diatas dapat dilihat pada tampilan berikut.

L7 Peta Kemiskinan

LB BB BB

Penduduk hidup di
bawah garis kemiskinan

16.Simpanlah hasil pembuatan layout peta dengan cara klik menu ‘Project’ >
‘Simpan’. Apabila kita akan membuat peta untuk indikator lainnya, maka
simpanlah file format QGS tersebut dengan nama lain.
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PRy |
Edit Tamplan Layer Pengaturan Plugi

Baru Cri+n .:
Buka.. criso
Layer baru dari Template

Open Recent

DWIG/DXF Import.

17.Peta tematik yang telah kita buat dapat kita simpan ke image atau PDF yang
nantinya dapat di tampilkan di dalam software Word atau Power Point. Pada
program QGIS, klik menu Composer > Export as Image kemudian arahkan ke
folder kerja kita yaitu di ‘C:\01_Pelatihan_FSVA \Layout’. Simpanimage dalam
format yang kita dibutuhkan (contohnya JPG, TIF, PNG dll) kemudian beri nama
(contohnya Peta kemiskinan 2018.jpg) dan klik tombol ‘Save’. Atur resolusi
image (contohnya 300 dpi) dan klik tombol ‘Save’.

/ Save composition as ==
@ yo[ 1l « System (C) » 0L Pelatihan FSVA » Layout %[ search Layaut )
U - =
Organize v  Newdolder = @
fDM ment [ Type 7 Image export options |2
M
New Composer... Cirl+N & Pict No its tch y Export optig
(2] e | B Resous i Booapr 2]
4| Composer Manager... N
age i .
Print Camposers v || & Homegroup
Page height 2480px =
Add Ttems from Tempate. . 8 Comput
_ & system (©) w [] Crop to content
s Dats (09 Top mardin [0
Wonear 2 o b Kiri Opx Kanan o
File nagffe: - Bawah  [opx
4 ExportasSiG.. oo A
Page Setip.. Chl+shift+
@ Cetck... Ctl+p =
B e ava || @ e D= 6 ) ) =
- See——

Layout peta dalam format JPG yang telah kita simpan akan seperti gambar dibawah
ini:

120 130 14

Penduduk hidup di
bawah garis kemiskinan

Legenda

2
[

[ Batas provinsi
% Penduduk Miskin
= B <10

Jw-<
[11s
= 20- <
I >s-<
B

15

<20
25
35

500 km

Cibvat aleh Tim FSVA, BKP, 17 danuan 2018

) T
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V. INSTALASI SOFTWARE QUANTUM GIS (GIS)

Sebelum memulai proses instalasi software QGIS, maka perlu dilakukan pengecekan
terhadap versi Windows yang terdapat pada computer anda (64 bit atau 32 bit) dengan
cara sebagai berikut:

1. Klik tombol Start dan pilih ‘Control Panel’ kemudian klik ‘System’ seperti
tampilan berikut ini:

@4 » Control Panel » System and Security »

’1* Action Center
U Review your computer's status and resolve issues | ) Change User Account Control settings

Troubleshoot commen computer problems | Restore your computer te an earlier time

Control Panel Home

* System and Security
Netwerk and Internet
Hardware and Sound ﬂ Winday,

e

Programs

ool

System
View amoun t of RAM and processor

ser Accounts and Family

&y Windows Update
-3 J Turn automatic updating on or off | Check for updstes | View installed updates
\1 Power Options

Change battery settings | Require a password when the computer wakes
Change what the power buttens do | Change when the computer sleeps

a& Backup and Restore

Back up your computer | Restore files from backup

A" Windows Anytime Upgrade
A Get more features with a new edition of Windows 7

tive Tools

e | Pafeammmant me hard drive

2. Informasi terkait versi Windows terdapat di dalam baris ‘System type’. Pada
contoh berikut maka versi Windows nya adalah 64-bit.

1% » Control Panel » System and Security » System

Control Panel Home . — -
View basic information about your computer
& Device Manager Windows edition

& Remote settings Windows 7 Professional

& System protection Copyright © 2009 Microsoft Corporation. All rights reserved.
) Advanced system settings Service Pack 1

Get more features with a new edition of Windows 7

System
Manufacturer: Dell
Rating: m Windows Experience Index
Processor: gre(TM) i5-5200U CPU @ 2.20GHz 2.20 GHz

Installed memory (RAM
System type:

Pen and Touch: s available for this Display

Dell support

Langkah-langkah instalasi software QGIS di bawah ini mengasumsikan Anda bekerja
dengan Sistem Operasi Windows. Installer QGIS disediakan di folder
'C:\01_Pelatihan_FSVA \Sofware’. Terdapat 2 versi installer di dalam folder ini
yaitu untuk windows versi 64 bit (QGIS-OSGeo4W-2.18.15-1-Setup-x86_64bit.exe)
dan untuk Windows versi 32 bit (QGIS-OSGeo4W-2.18.15-1-Setup-x86_32bit.exe).

Berikut adalah langkah-langkah instalasi software QGIS:
1. Klik 2 kali pada file installer yang terdapat di folder

'C:\01_Pelatihan_FSVA\Sofware’. Pada contoh berikut kita akan menggunakan
installer yang versi 64 bit (disamakan dengan versi Windows dari computer).
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2. Klik tombol‘Next’ kemudian klik tombol ‘I Agree’seperti dibawah ini:

"Las Palmas’ Setup

=l e # QIS 2.18.15 'Las Palmas' Setup

o] [

Palmas' Setup Wizard

é Welcome to the QGIS 2.18.15 "Las Please revie

License Agreement 2
iew the license terms before

instaling QGIS 2. 18,15 "Las Palmas', %

Press Page Down to see the rest of the agreement.

ugh the installation of QGIS

cud you e

nded that you close all other
aSetup. Thi \Imakelp <o m pth
system fls without having toreboat

1. Licer

Ifyou

of the
agreemen ttn taHQG[SZlB 15L

of 'QaIs' i

ety kT Agre tocontinae, You m@
P

TN e

g

3. Untuk folder instalasi ( Destination folder) default-nya berada di folder ‘C:\Program
Files\QGIS 2.18’ sehingga tidak perlu merubah lokasi folder tersebut. Klik tombol

‘Next’'.

% QGIS 218,15 Las Palmas’ Set.up‘

= 23

Choose Install Location [ﬂ

Choose the folder in which to install QGIS 218,15 'Las Palmas’, 8

smp \I BI\QG[SZlBJSL s Palmas’in the following folder. T installin a different
folder, and select another folder, Click Next to continu

Destination Folder

 Program Files \QGIS 2.16]

Browse...

O,

[ <Back [l next= D[ Cancel |
\
R

Space required: 1.6GB
Space available: 117.268

4. Untuk pilihan komponen (Choose component) hanya pilihan QGIS saja yang di
centrang kemudian klik tombol ‘Install’. Sehingga proses instalasi software akan

segera berjalan dengan otomatis.

# QGIS 2.18.15 "Las Palmas’ Setup E‘_‘éj . QGIS 2.18.15 "Las Palmas’ Setup E‘_l_J
Choose Components 2 Installing 2
Choose which features of QGIS 2.18. 15 'Las Palmas’ you want to install, % Please wait while QGIS 2. 18, 15 Las Palmas' is being installed. Y&

Check the components you want to instal mpenents you don't want to Extract: mac_farsi.py
install. Click Install to start the installation. i =

Show details

Desaription '

O,

Cancel
v 4

—

Select components to install: ‘
l Morth Gffolina Data Set
g Dakots (Spearfish)
D Alaska Data Set

Space required: 1,668

< Back. Install

5. Setelah proses instalasi selesai akan muncul tampil berikut, klik tombol ‘Finish’

untuk mengakhiri proses instalasi.

Sebaiknya lakukan proses ‘Restart’ pada

computer Anda sebelum menjalankan software QGIS.
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7 QGIS 2.18.15 'Las Palmas’ Setup oo
N .

>

@ Completing the QGIS 2.18.15 'Las
Palmas' Setup Wizard

QGIS 2.18.15 'Las Palmas' has been installed on your
o computer.

Click Finish to dlose this wizard.

Finish

N

6. Setelah computer di restart maka software QGIS siap untuk digunakan. Untuk
mengakses software QGIS dilakukan dengan mengklik tombol ‘Start’ kemudian
pilih ‘All Programs> QGIS 2.18>QGIS Dekstop 2.18.15".

7. Untuk memudahkan pencarian software QGIS maka dapat dibuat shortcut dari
software QGIS tersebut dengan cara klik kanan pada ‘QGIS Dekstop 2.18.15lalu

klik ‘Send to’ > ‘Desktop (create shortcut)'.

| Dropbox Evernoti e
Evernote Games Pin to Taskbar
Games Hotspo Pin to Start Menu

) :stsw TEDGO Send by Bluetooth to
LEGO MINDSTORMS Edu MXT 2.0 Mainter &  Scan With Smadav
Maintenance

| Microsoft Office 2016 Tools
Minecraft
MVIDIA Corporation

QGIs218
4 GRASSGIS7.22

& 05GeotW Shell

[ sAGA GIS (23.2)
& Setup

4 Back

4 Delete
@ QGIS Browser 2.18.15 with GRASS 7.7 & Qa1 _ @
< ) Rename
Z Desktol 1

[ Search programs and fies o] B [Ssearchp

@ FcE n 2 6w

2]

xH °Li r3 val
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